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Why BioSigRZ? 

For years, SigGenRP and BioSigRP have combined to offer the most versatile software available 
for ABR and DPOAE studies without requiring researchers to do any programming or scripting. 
BioSigRZ, the newest version of this powerful software tool, takes our goal of making easy-to-use 
software to a new level. With those years of experience supporting BioSigRP, we've learned 
which features and configuration options are most important to customers and which options can 
be preconfigured for the vast majority of users. We've streamlined the interface and provided 
standard configuration files that make BioSigRZ an out-of-the-box solution for ABR and DPOAE 
screening and research studies without sacrificing the flexibility crucial to TDT customers.  

Ongoing Support of Customization for Maximum Flexibility 

In earlier versions of the software, users would begin by designing custom stimuli in SigGenRP 
and could even customize signal generation, presentation, or processing at the most fundamental 
level using RPvdsEx for circuit design. Both of these tools allow complete customization without 
requiring programming, however, for many users this level of customization is unnecessary and 
using these tools adds time and complexity to the configuration process. Earlier versions of 
SigGenRP and BioSigRP also required users to develop calibration strategies to efficiently 
calibrate their individual system, another time consuming and complex process. Once these two 
tasks were complete, stimulus design and calibration were pulled together along with customizable 
data acquisition and analysis tools and implemented through BioSigRP. This highly flexible path 
is still available in SigGenRZ and BioSigRZ, but most users will employ greatly simplified 
process.  

A New Streamlined Approach Meets the Needs of Most Users 

With this most recent version of the software, you can simply open BioSigRZ, load a standard 
configuration, specify a speaker (and microphone, for DPOAE) and begin signal acquisition. No 
need to use SigGenRZ or RPvdsEx and, typically, no calibration is necessary. Everything is done 
from BioSigRZ—a single simplified interface. Everything is done from BioSigRZ—a single 
simplified interface. If the stimulus schedule or variables provided in the standard configuration 
don't meet your needs, they can be modified directly in BioSigRZ. TDT provides calibration files 
for common speakers and microphones, so calibration is as easy as selecting the transducer or 
microphone from a list. If you choose to make modifications, changes can be saved to the 
BioSigRZ configuration for future trials.  

New Hardware Support Further Simplifies Setting up and Running Experiments 

Because BioSigRZ is designed to run on the RZ6 Multi I/O Processor, both ABRs and DPOAEs 
can be run using a single RPvdsEx circuit operating at ~200 kHz. No more concerns with 
bandwidth limitations or processing speeds. Hardware set-up is also greatly simplified. One device 
handles both signal presentation and data acquisition and provides onboard attenuation and signal 
conditioning, allowing direct connection of transducers and microphones.  

BioSigRZ and the RZ6 combine to make ABR and DPOAE experiments easier to run while 
preserving the flexibility TDT users have come to expect.  
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Organization of the Manual 

The BioSigRZ Manual is divided into two parts:  

 Part 1 BioSigRZ Quick Start 

 Part 2 Reference Guide 

BioSigRZ Quick Start 

Part 1, BioSigRZ Quick Start, is designed to help you get up and running quickly. A tutorial is 
used to introduce all the basic BioSigRZ concepts necessary to present a stimulus signal and 
acquire data. It also provides an introduction to BioSigRZ's capabilities and features. 

Overview 

An introduction to the software, including features, system requirements, and hardware setup; is 
provided in the following section: 

o Chapter 1   Overview 

Quick Start Example 

Most users will be able to run experiments with little or no configuration, using provided 
experiment files. A step-by-step example for using standard configuration files is provided in the 
following section: 

o Example 1: ABR Using a Click Stimulus 

Reference Guide 

Part 2 contains a reference guide to the workspace, experiment configuration, data acquisition, and 
data analysis. The four general components of the software are listed below along with their 
associated chapter. 

o Chapter 2   Workspace Basics - the workspace, menus, and toolbars 

o Chapter 3   Configuration – stimulus and acquisition set-up 

o Chapter 4   Data Acquisition - presenting the stimulus and acquiring response data 

o Chapter 5   Data Analysis – using the calculator and worksheet for post analysis 
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Chapter 1   Overview  

Welcome to BioSigRZ, TDT’s RZ6 compatible stimulus presentation and data acquisition 
package for ABR and DPOAE screening and research studies.  

What Is BioSigRZ? 

BioSigRZ is a powerful, yet easy-to-use, tool designed to automate the process of presenting 
stimulus signals and acquiring response signal data. BioSigRZ works with the RZ6 Multi I/O 
processor and supports stimulus customization using TDT’s signal design software, SigGenRZ. 

BioSigRZ Capabilities and Features 
BioSigRZ’s capabilities and features include: 

o Standard configurations for ABR and 
DPOAE 

o Standard speaker and microphone profiles 

o Stimulus schedule customization 

o Stimulus variable customization 

o Dual-channel stimulus 

o Artifact rejection 

o Averaging  

o Stimulus schedule override  

o Historical data display 

o Comparison data display 

o Calculator 

o Detail display 

o Cursors 

o Report generation 

o SigGenRZ file support 

Standard Configurations for ABR and DPOAE 
Standard configuration files enable you to run ABR and DPOAE screening protocols out-of-the 
box with little or no software configuration beyond basic installation. 

Standard Speaker and Microphone Profiles 
Standard speaker and microphone profiles are provided for TDT speakers and microphones 
typically used with the RZ6. In most cases a profile can be selected and no further calibration is 
required. 

Stimulus Schedule Customization 
Standard or custom stimulus files include a stimulus schedule that specifies how variables change 
during stimulus presentation. The stimulus can be presented over multiple intervals with signal 
parameters varied as a function of each interval.  

The SigGen Index (SGI) is another name for the interval number. You may customize the SGI 
from within BioSigRZ. 

Stimulus Variable Customization 
BioSigRZ supports direct customization of stimulus variables such as frequency, level, and 
attenuation. 
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Dual-Channel Stimulus 
BioSigRZ enables you to present dual-channel stimuli.  

Artifact Rejection 
BioSigRZ’s artifact rejection provides a means for rejecting signals with anomalous amplitude 
values. 

Averaging 
BioSigRZ maintains a running average that you can view as signals are acquired. Averaging 
continues until the desired number of signals is acquired. 

Stimulus Schedule Override 
BioSigRZ provides several command functions that allow you to manually override the stimulus 
schedule during stimulus presentation. These functions include: Advance, Skip, Repeat, and ReDo. 

Historical Data Display 
As averages are completed, resulting waveforms are displayed in a history plot and are appended 
to a file known as the BioSigRZ Record file (.arf file). 

Comparison Data Display 
You can compare historical data records with newly acquired records.  

Calculator 
Using a built-in calculator, you can perform a variety of mathematical operations on acquired data. 

Detail Displays 
You may view any record in more detail. BioSigRZ provides two detailed displays: a detailed 
Time-Domain Plot and a corresponding Frequency-Domain Plot. You can zoom-in on any portion 
of either display. 

Cursors 
BioSigRZ allows you to obtain information about instantaneous level at various points in time 
through the use of cursors. 

Report Generation 
You can generate custom reports consisting of historical signal data. A worksheet area of the 
BioSigRZ main window can be used to build these reports. 

SigGenRZ File Support 
BioSigRZ takes advantage of the powerful signal generation capabilities of TDT’s signal design 
software, SigGenRZ. BioSigRZ reads SigGenRZ files (.sig files) and uses the signal parameters 
stored in these files to generate stimulus signals over successive SigGenRZ Indices (SGIs). Most 
users will not need to work directly with SigGenRZ, however, it provides a means of designing 
custom stimuli. 
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How to Use BioSigRZ 

BioSigRZ is designed to collect and analyze data such as auditory brainstem response (ABR) data 
and distortion product otoacoustic emission (DPOAE) data. It enables you to acquire and process 
bioelectric signal data in response to a stimulus signal.  

Workflow for Initial Experiment Set-Up 
Most users will use BioSigRZ as follows: 

1. Load a pre-existing Configuration file provided with BioSigRZ. 

2. Select your transducers and microphones. This step ensures your system will be 

calibrated for your speakers and microphones. No manual calibration is required. 

3. If needed, modify the pre-existing stimulus variables. 

4. Save the BioSigRZ configuration with a new name. 

Saving the file, saves any modification you have made to the experiment configuration, 

stimulus, and variables. When you are ready to run the experiment it is as simple as 

loading the file, specifying a record file where data will be saved, and collecting the data. 

BioSgRZ also supports complete customization of the configuration or stimuli for users who 

require it. For users who wish to design custom stimuli, see the SigGenRZ Manual. 

Workflow for Daily Operation 
Once your experiment hardware and software configuration is established, you can use BioSigRZ 
as follows: 

1. Load your BioSigRZ configuration file (created above). 

2. Prepare the subject. 

3. In BioSigRZ, specify a Response Record File where data will be stored for the current 

trial or subject. 

4. Begin averaging and data collection. 

5. End data collection, then process and Analyze the response data. 

Standard BioSigRZ Configuration Files 
BioSigRZ provides standard configuration files in the C:TDT\BioSigRZ\Configs folder: 

1. ABR\Root_ClickAbr.acf - A 0.1 millisecond, single-channel mono-phasic click will be 
presented. With each successive presentation, the click phase will alternate between a 
condensation and rarefaction click. Click level will vary from 90 dB SPL to 10 dB SPL in 
10 dB decrements. A single channel acquires the response through the use of an RA4PA 
preamplifier via the RZ6 fiber optic port. A total of 512 responses will be averaged at 
each level.  

2. ABR\Root_ToneAbr.acf - A five millisecond, single-channel tone with a 3 millisecond 
gate time will be presented at the following frequencies: 4000 Hz, 8000 Hz, and 16000 
Hz. For each frequency, the tone level will vary from 90 dB SPL to 20 dB SPL in 10 dB 
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decrements. With each successive presentation, the tone phase will alternate 180 degrees 
to reduce artifacts. A single channel acquires the response through the use of an RA4PA 
preamplifier via the RZ6 fiber optic port. A total of 512 responses will be averaged at 
each frequency and level combination. 

3. DPOAE\Root_DPOAE.acf - Distortion-product otoacoustic emission (DPOAE) data 
will be collected in response to a combination tone presented continuously.  The integrity 
of the cochlea will be measured at the following audiometric frequencies: 4000 Hz, 8000 
Hz, 16000 Hz, and 32000 Hz.  The frequencies of Channel A and Channel B will be 
geometrically centered about the audiometric frequency.  That is, the frequency of 
Channel A (F1) will be the audiometric frequency multiplied by a factor of 0.909 and the 
frequency of Channel B (F2) will be the audiometric frequency multiplied by a factor of 
1.09, so that F2/F1 = 1.2. The level of the two primary tones will remain equal and will 
vary from 80 dB SPL to 20 dB SPL in 10 dB decrements.  A single channel microphone 
response is acquired using the RZ6 In-A connector. 

System Requirements 

In order to run BioSigRZ, you must have the following: 

o Computer running 32-bit Windows XP, Windows Vista, or Windows 7 

o TDT drivers (72 or higher) 

o Super VGA (1024 x 768) resolution graphics (or higher) 

o RZ6 Multi I/O processor 

o Optibit Interface Card in your PC to communicate with RZ6 

Hardware Configuration 

BioSigRZ works with TDT’s powerful RZ6 Multi I/O processor to acquire and average signals 
and to view signal responses to complex stimulus patterns. All acquisition and signal generation 
are performed using a single RZ6 processor. Typical configurations for ABR and DPOAE are 
shown in the diagrams below.  

Typical ABR Configuration 

 
 

In a typical configuration for ABRs the RZ6 provides digital to analog conversion while an 
RA4PA preamp and RA4LI headstage provide data acquisition and analog to digital conversion. 
The RZ6 provides programmable and manual attenuation for stimulus channel A and drives a 
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single speaker to present the stimulus. Other device outputs can be used to support alternative 
transducers. 

Typical DPOAE Configuration 

 
 

In a typical configuration for DPOAEs the RZ6 provides stimulus generation, programmable and 
manual attenuation for two stimulus channels and drives either two electrostatic speakers or other 
speakers to present the stimulus. 

When not using the electrostatic speakers use Out-A and Out-B, these outputs and the stereo A&B 
headphone output can be used to support other transducers, such as the ER2C from Etymotic.  

Response acquisition is handled by the ER-10B microphone system from Etymotic while analog 
to digital conversion is performed on the RZ6 through ADC channel A. 

Eliminating Electrical Noise in ABRs 
Noise peaks that occur at regular intervals can occur when the system is affected by 60 Hz (or 50 
Hz for international users) electrical noise. You might not see the peak at 60 Hz if you have a 60 
Hz notch filter in place, but harmonics can still be present. Here are some ways to minimize 
BioSigRZ recording problems related to electrical noise:  

Make sure the RA4PA charger is disconnected. 

Record in an environment where the 60 Hz noise is limited (such as in a Faraday cage), away from 
other electronics that are connected to a power outlet. 

Ensure that the electrode impedances are as close together as possible. If you are using a 2 kOhm 
electrode and a 4 kOhm electrode, you will only get a reduction in the 60 Hz noise and its 
multiples by half (as opposed to virtually eliminating it in the amplifier). A differential amplifier 
will eliminate signals that are common to both the recording and reference electrodes. If the 
impedances of these electrodes are different, the common signals will have different voltages and 
not be subtracted out completely. Use the impedance check function on the RA4LI to measure the 
impedance of Ch1 and Ref(-). They should be equal and should be 1-3kOhm. If they are not equal, 
reposition the electrode that is reading the higher impedance. If they are both higher than 3kOhm, 
reposition the ground electrode. 

BioSigRZ File Types 

BioSigRZ uses or writes to seven types of files: 

o BioSigRZ configuration files (*.acf) 

o SigGenRZ files (*.sig) 
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o Calibration files (*.tcf) 

o BioSigRZ response record files (*.arf) 

o BioSigRZ worksheet files (*.awf) 

o ASCII text files (*.txt) 

o CSV files (*.csv)  

BioSigRZ Configuration Files 
Stimulus and data acquisition parameters are saved as part of the BioSigRZ configuration file. The 
extension for BioSigRZ configuration files is .acf. 

SigGenRZ Files 
Standard stimulus files are provided with BioSigRZ and specification of the appropriate file is 
preconfigured in each of the standard configuration files. Stimulus signals are designed with 
TDT’s signal generation package, SigGenRZ. BioSigRZ uses information saved in a SigGenRZ 
file to reconstruct the stimulus signal and vary it according to defined variables. The extension for 
SigGenRZ files is .sig.  

Calibration Files 
Standard calibration files for common speakers and microphones are provided with BioSigRZ. If a 
calibration file is not provided for your specific model, contact TDT for assistance. Prior to 
presenting a stimulus signal or acquiring data, you may specify calibration file(s) for your 
hardware. The extension for calibration files is .tcf. 

BioSigRZ Record Files 
For every stimulus interval, or SigGenRZ Index (SGI), BioSigRZ acquires response signals and 
computes an average. The resulting averaged waveforms are collectively stored in a BioSigRZ 
record file. These waveforms may be retrieved for analysis in later sessions. Waveforms retrieved 
from BioSigRZ record files are displayed in a history plot. The extension for these files is .arf.  

BioSigRZ Worksheet Files 
BioSigRZ allows you to build custom reports. Custom reports are created by placing desired 
historical plot records into a worksheet plot. These reports may be saved in BioSigRZ Worksheet 
files. The extension for these files is .awf. 

ASCII Text Files 
You may wish to export BioSigRZ record information to an ASCII text file for use by another 
application. BioSigRZ allows you to export record information in ASCII text format. These files 
are saved with the extension, .txt.  

CSV Spreadsheet Files 
BioSigRZ allows you to export raw trace data with descriptions into a standard spreadsheet file 
(CSV files). Each row in the spreadsheet file contains all of the data for one record.  

 

 



 

Example 1: ABR Using a Tone 
Stimulus 

This example introduces BioSigRZ's streamlined interface and will illustrate the three types of 
workflows you're likely to use in your lab. 
 

o Initial Experiment Setup – The first time you set up an experiment, you'll select one of 
the standard configurations provided, setup your system, update the configuration file to 
match your hardware, and save the project with a new name. The experiment and any 
other modifications you make will be saved as part of the configuration.  
 

o Daily Operation – Once a configuration has been setup for your experiment, daily 
operation is as simple as loading a file, prepping your subject, and collecting data. 
 

o Modifying Stimulus Variables – The standard configuration files provide the most 
common variable values, but you can easily modify them directly in BioSigRZ. Once 
changes are made they are saved in the configuration file for future trials. 

Initial Experiment Setup 

To setup the experiment for the first time, you will need to perform the following steps: 

1. Connect the hardware. 

2. Run BioSigRZ. 

3. Load the standard configuration file.  

4. Select your transducer and device input. 

5. Specify a response record file.  

6. Save the configuration with a new name. 

Connect the Hardware 
Before running an experiment, TDT hardware must be set-up and turned on. See the Installation 
Guide provided with your system for set-up instructions. The diagram below illustrates typical 
wiring connections for an ABR experiment.  
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The stimulus is generated on Channel A. A single transducer is connected to this output channel. 
If a magnetic speaker is used (such as the FF1 or CF1), connect it to Out-A and make sure the 
Electrostatic switch is in the ‘OFF’ position. If an EC1 or ES1 electrostatic speaker is used, 
connect it to Electrostatic -A- and turn the Electrostatic switch to ‘ON’.  

The RA4PA preamp is connected to the optical port on the front panel for data acquisition. The 
RA4LI is connected directly to the RA4PA. Electrodes from the subject connect to the RA4LI 
touch-proof connectors. 

Run the BioSigRZ Software 

To run BioSigRZ: 

 Double-click the BioSigRZ  icon.  
 
or  

 Click the Start menu, point to Programs, point to TDT Sys3, point to the SigGen Solutions 
folder, and click BioSigRZ. 

Load the Standard Configuration 
In this example you'll begin with the standard configuration below for collecting auditory 
brainstem response (ABR) data in response to a pure tone stimulus: 

C:\TDT\BioSigRZ\Configs\ABR\Root_ToneAbr.acf  

Configuration files include information about how data will be acquired, such as number of 
averages, as well as information about the stimulus schedule and how it will be presented.  

In this experiment, five millisecond tones with a gate time of three milliseconds will be presented 
at the following frequencies: 4000 Hz, 8000 Hz, and 16000 Hz. For each frequency, tone level will 
vary from 90 dB SPL to 20 dB SPL in 10 dB decrements.  

To load the configuration file: 

1. Click the File menu and click Open Config. File 

2. Select the C:\TDT\BioSigRZ\Configs\ABR\ Root_ToneAbr.acf file in the Open dialog box 
and click Open. 

Before you can run the experiment you must specify a calibration file that corresponds to the 
transducer you will be using.  

Select Your Transducer and Device Input 
To simplify experiment setup and save you time, BioSigRZ is provided with calibration files for 
the most commonly used transducers and headstages/amplifiers. Additional calibration files can be 
downloaded online at: http://www.tdt.com/support.htm  

http://www.tdt.com/support.htm�
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To select your speaker calibration: 

1. Click the Setup menu and click Stimulus. 
 

 
2. In the Stimulus Setup dialog click the Browse button under Speaker Calibration. 

 
In the Specify a Speaker Calibration File window, calibration file names provide 
information about the type of speaker and calibration. For example, FF1_10cm is a 
calibration file for the FF1 free field speaker calibrated at 10 cm from the subject. Several 
files are also provided for closed-field speakers positioned at several different distances 
(depending on the length of tubing in use).  

3. Select the appropriate file for your setup and click Open. 
 

 

Browse for 
speaker 
calibration
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4. In the text area below Speaker Calibration, review the calibration information.  
 
To ensure the accuracy of the calibration, set the manual attenuation on your RZ6 
according to any gain value used in the calibration. For example: for the FF1_10cm 
calibration shown above you must set your manual attenuation on the RZ6 to -6dB. 

5. Click OK. 

To specify your device input calibration 

1. Click the Setup menu and click Acquisition. 
 

 
2. In the Acquisition Setup dialog click the Browse button under Microphone Calibration.  

 
In the Specify a Microphone Calibration File window, calibration file names provide 
information about the type of device input (microphone or headstage). For example, 
RA4LI.tcf is a calibration file for the RA4LI headstage calibrated with the RA4PA 
amplifier. 

3. Select the appropriate file for your setup and click Open. 
 

 

Browse for 
device input 
calibration
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4. In the text area below Microphone Calibration, review the calibration information.  

5. Click OK. 

Specify a Response Record File 
You can specify where the data will be saved in the Acquisition Setup dialog box. 

To specify a record file: 

1. Select Acquisition from the Setup menu or click the Setup Acquisition  button. 
 

 
 
Response record files (.arf) are continuously maintained during data acquisition. Each 
averaged record is appended to the history record file.  

2. In the Name field, type a new file name or browse to a new location or file.  

3. Ensure the Prompt for File Name check box is selected to be prompted for a new file 
name before stimulus presentation begins. 

4. Click OK. 

Save the .acf File 

To save the configuration file: 

1. Select Save Config. As from the File menu. 

2. Enter a name in the File Name field. 

3. Click Save. 

Note: For 
DPOAE 
experiments 
you would 
select your 
microphone 
here. 

Specify a 
record file 
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Daily Operation 

Daily operation in BioSigRZ is a very straight forward process once the initial experimental setup 
has been completed.  

To perform daily operations you will:  

1. Load your saved configuration. 

2. Prepare the subject. 

3. Review the input/output settings. 

4. Run the experiment 

Load your Saved Configuration 
You may load your initial setup configuration to perform daily operations for BioSigRZ. 

To load the configuration file: 

1. Click the File menu and click Open Config. File  

2. Browse to the location of your saved configuration file (*.acf) and click Open. 

Prepare the Subject 
At this time prepare the subject for experimental trial(s). 

Review the Input/Output Settings 
When making changes to an existing configuration file it is useful to quickly review or verify that 
the input/output configuration matches the equipment and transducer you are using. 

To view input/output settings of the loaded BioSigRZ configuration file: 

DAC output 
channel 

Input  
channel 

Transducer 
calibration file 

Amplifier/headstage 
calibration file 
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1. Click the Review Button. This prompts the Transducer Setup and Settings dialog.  
 
From the review dialog, the stimulus will be output on channel A, input will be acquired 
from Bioamp Channel 1, and the system is currently calibrated for an FF1 magnetic 
speaker at 10 cm with device input coming from an RA4LI headstage and RA4PA 
preamp. RZ6 manual attenuation should be set to -6dB. 

2. After you have reviewed the dialog and verified that the setup is correct, click Done. 

Run the Experiment 
You can begin stimulus presentation or run the experiment using buttons on the left side of the 
BioSigRZ main window.  

 

Running 

To begin stimulus presentation: 

1. Click the Start button. You will be prompted to specify a response record file where data 
will be stored.  

2. Type a name in the File Name field and click Open. 

You are now in Running Mode.  

The stimulus signal is presented using the first SigGen Index. No data is collected.  

Averaging 

To begin data averaging: 

1. Click the Begin button. 

2. A Subject Information window opens. Information entered here is stored with the data in 
the response record file.  
 

 
3. Enter any subject information and click OK. 

You are now in Averaging Mode.  

The first stimulus is repeatedly presented and the ABR response data is acquired and included in 
the running average until the desired number of responses has been collected at that level. In this 
experiment the number of responses averaged at each stimulus level is 512.  
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As averages are completed, the averaged ABR records will be appended to the History plot and 
the .arf file.  
 

 

Termination 
Once the boundary conditions have been met, BioSigRZ will automatically terminate data 
averaging. However, you may manually terminate data averaging at any time.  

To manually terminate data acquisition: 

 Click the End button. 

At this point, you may halt stimulus presentation or run the experiment again. 

To halt stimulus presentation: 

 Click Stop. 

To run the experiment again: 

1. Click Begin. 

2. Enter in the new subject information. 

See Chapter 4 Data Acquisition for more information on tools to control and streamline data 
acquisition and see Chapter 5 Data Analysis for more information on analyzing data during or 
after data collection. 
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Modifying a Stimulus Variable 

As mentioned before, the standard ABR tone configuration probes the following frequencies: 4000 
Hz, 8000 Hz, and 16000 Hz. Depending on the desired subject, you may wish to change the values 
of these probe frequencies. For example, for a mouse subject you might wish to probe 32000 Hz. 

To modify a stimulus variable you will:  

1. Load your saved configuration. 

2. Review the stimulus variables. 

3. Modify the frequency variable. 

4. Save the modified configuration. 

Load the Saved Configuration 

To load the configuration file: 

1. Click the File menu and click Open Config. File  

2. Browse to the location of your saved configuration file (*.acf) and click Open. 

Review the Stimulus Variables 

To review the stimulus variables and schedule: 

 Select SigGen Variables from the Setup menu or click the Modify SigGen Variables  
button. The SigGen Variable Control dialog opens. 
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All of the variables which define the stimulus signal are displayed within this dialog. From 
here you can modify the stimulus schedule or modify the variables themselves. 

The Stimulus Schedule 
The SigGen Index (column 1) shows the order in which each variable condition, or SGI, will be 
presented. You can select a subset of conditions to run using standard Windows® techniques. For 
more information, see Modifying the Stimulus Schedule, page 65. 

Modifying Variables 
Variables change the signal parameters as a function of the SigGen Index (SGI) and can be 
modified in BioSigRZ through the use of the Signal Variable dialog. See General Variable 
Parameters in the SigGenRZ Manual for more information on the variable parameters.  

Note: When modifying the frequencies to be probed, make sure you use only frequencies in the 
calibrated range (see the speaker calibration notes for more information). 

To modify the Freq variable: 

1. In the SigGen Variable Control dialog, click the Freq button.  
 
The Signal Variable dialog opens. 
 

 
 
The variable Freq has been defined using the Value List method type.  
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2. To add the desired frequency to the list, click the Edit List button.  

3. In the Edit Value List dialog, add the value 32000 to the bottom of the list. 

 
4. Click OK. 

5. Click OK. 

 
The frequency 32000 has been added to the schedule. 

6. Click OK. 
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Save the .acf File 

To save the configuration file: 

 Select Save Config from the File menu. 

Saving the file, saves any modifications you have made to the experiment configuration or 
stimulus variables.  

When you are ready to run the experiment again it’s as simple as loading the file, specifying a 
record file, adding subject information, and collecting the data. 

 



 

Part 2 Reference Guide 
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Chapter 2   Workspace Basics 

Getting to Know the BioSigRZ Main Window 

BioSigRZ’s main window is designed to provide customizable visual displays of the stimulus 
signal, raw response signals, running averages, history data, and reports. 

The Start-up Window 
Upon starting BioSigRZ, you will see the main BioSigRZ window. If you are running BioSigRZ 
for the first time, the main window will appear in its default layout, as seen below. 

 

     
 

The window contains the following sections: 

Title Bar: Displays “BioSigRZ Windows Application” and the name of the current BioSigRZ file. 

Menu Bar: Contains a list of menus used for building, manipulating, and saving your BioSigRZ 
file. 

Toolbar: Provides easy-to-use icons for the most common BioSigRZ Menu commands. 

Multi-Purpose Plot: May be used to display a plot of the stimulus signal, the raw A/D signal, the 
FFT of the signal, the EEG signal, or the running average. 

History Plot Area: Is used to display historical, averaged signal data. 

Current Info: Displays the current SigGenRZ Index (SGI) plus variable names and their current 
values. 

History Info: Displays Group information. Responses obtained during the same data acquisition 
session are collectively referred to as a Group. Groups are automatically sequentially numbered. 
For each History Plot record, the names and values of variables are displayed.  

Calculator: Allows you to perform mathematical operations on one or more Worksheet records. 

Worksheet: May be used to store records for use in calculations and to build reports. 

Sizing Bars: Allow the user to resize each area of the screen. 

Status Bar 

Title Bar 

Menu Bar 

Toolbar 

History 
Info 

History 
Plot Area 

Worksheet 

Sizing 
Bars 

Muli-Purpose Plot 

 

 

Calculator 

Worksheet Buttons 

Current Info 
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Status Bar: Provides information about the selected command. 

The Customized Window 
BioSigRZ provides numerous displays. Depending on your needs, you may wish to enlarge some 
displays and reduce others. 

To enlarge/reduce a display area: 

 Drag the appropriate Sizing Bar. 

Below, the BioSigRZ main window is configured to provide more room in the Worksheet area. 
The Calculator area has been expanded so that most calculator and worksheet buttons are visible. 
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Using the BioSigRZ Menus 

BioSigRZ provides the user with a full set of menu commands. From these menu commands, you 
can create, open, and save files; customize screen displays; present stimulus signals; acquire 
response data; and analyze data. 

The File Menu 

 
The File Menu provides a standard Windows method for creating, saving, opening, closing, and 
printing files. 

New Config: Resets all screen objects to their default states and clears all plots. 

Open Config. File: Opens and displays an existing BioSigRZ configuration file (.acf file). 

Save Config and Save Config. As: These menu options save BioSigRZ configuration data in a 
BioSigRZ configuration file. Files saved with this format use the default extension .acf.  

Target Device: Prompts the device selection window. 

Print: Prints the current Worksheet Area. 

Print Preview: Allows you to view the Worksheet Area as it will be printed. 

Print Setup: Allows you to select a printer, define the paper size, and choose a page orientation. 
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The Setup Menu 

 

 
 

From the Setup Menu, you can define stimulus 
and acquisition parameters, adjust stimulus 
parameters, calibrate the system, enter subject 
information, and customize the BioSigRZ 
interface. 

 

 
Stimulus: Opens the Stimulus Setup dialog box. From this box you can specify up to two 
SigGenRZ stimulus signals and define presentation parameters. 

Acquisition: Opens the Acquisition Setup dialog box, from which you can set timing parameters, 
define the default record file (.arf file), and configure up to four acquisition channels. 

SigGen Variables: Opens the SigGenRZ Variable Control dialog box. From this dialog box, you 
can customize stimulus presentation. 

Calibration: Opens the calibration review dialog. See page 62 for more information  

Subject Info: Opens the Subject Information dialog box. This dialog box contains fields where 
you can enter identifying information for the subject. 

Default Cursor Strings: Opens the Specify Default Cursor Text dialog box, from which you can 
customize cursor labels. 

Auto-Cursors: Opens the Specify Auto-Cursor Equations window, from which you can specify 
the location of up to 10 cursors. These cursors will be automatically placed during data 
acquisition. 

History Info Window: Opens the Info-Bar Setup dialog box, from which you can customize the 
History Info display area. 

General Display Ops: Opens the General Display Options dialog box. From this dialog box, you 
can customize background colors, plot colors, text colors, and other display characteristics of the 
main window, Multi-Purpose Plot, and History Plot. 

Worksheet Display Ops: Opens the Worksheet Display Options dialog box. From this dialog 
box, you can customize various display features of the Worksheet. 

Layout: Displays a submenu, you can use to select a screen layout. 

Use #1, Use # 2, Use #3: Switch between three custom defined screen layouts. 

To Default: Returns the screen layout to its initial, default layout. 

Lock: Locks/unlocks the current screen configuration. 
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The Operations Menu 

 
Idle 

 
Running 

 

The Operations Menu provides a list of commands that control the presentation of the stimulus 
signal and the acquisition of response signals. Menu options vary, depending on the current 
operational mode. Operational modes consist of the following: 

o Idle 
No stimulus presentation or data acquisition. 

o Running 
Stimulus is being presented. 

o Averaging 
Response data is being acquired and averaged. 

o Paused 
Data averaging has been temporarily suspended. 

Start: Begins the presentation of the stimulus signal. This menu option appears in Idle mode only. 

Stop: Discontinues the presentation of the stimulus signal. This menu option appears in Running 
mode only. 

Begin: Begins the process of data acquisition and signal averaging. This menu option appears in 
Running mode only. 

End: Discontinues data acquisition and signal averaging. This menu option appears in Averaging 
mode only. 

Pause: Temporarily halts data averaging. This menu option appears only in Averaging mode. 
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Averaging 

 
Paused 

Resume: Resumes data averaging. This menu option appears only in Paused mode. 

Advance: Causes the stimulus to advance to the next SGI. This menu option is enabled in 
Averaging and Paused modes. 

Skip: Causes the stimulus to skip the current SGI. This menu option is enabled in Averaging and 
Paused modes. 

Repeat: Saves the current running average, re-presents the same stimulus, and saves the resulting 
averaged signal. This menu option is enabled in Averaging and Paused modes. 

ReDo: Discards the current running average, re-presents the same stimulus, and saves the 
resulting averaged signal. This menu option is enabled in Averaging and Paused modes. 

Continuous: Enables continuous data acquisition. BioSigRZ will continue to acquire and average 
response data for the same stimulus until Continuous is disabled or the Advance, Stop, Repeat, 
ReDo, or End buttons are clicked. 

Repeat Each SGI: Acquires two averaged signals for each SGI specified in the stimulus schedule. 

Threepeat Each SGI: Acquires three averaged signals for each SGI specified in the stimulus 
schedule. 

Manual SGI Control: Enables the Next SGI and Previous SGI buttons and menu options. These 
buttons can be used to manually control the SGI. 

Next SGI: Advances the stimulus to the next SGI  

Previous SGI: Moves the stimulus back to the previous SGI. 

Modify Schedule: Opens the SigGenRZ Variable Control dialog box. From this dialog box, you 
can customize stimulus presentation. 
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The View Menu 

 
From the View Menu, you can turn various visual displays on or off. 

Tool Bar: Shows/hides the Tool Bar. 

Status Bar: Shows/hides the Status Bar. 

Dyn Controls: Displays all active Dynamic Control windows. Dynamic controls can be enabled 
for the desired variable in the Signal Variable dialog.  

Expand Scale: Expands the scale of the focus plot. 

Reduce Scale: Reduces the scale of the focus plot. 

Auto-Scale: Automatically scales the focus plot. 

Toggle Chan – 1: Shows/hides Channel 1 on the focus plot. 

Toggle Chan – 2: Shows/hides Channel 2 on the focus plot. 

Toggle Chan – 3: Shows/hides Channel 3 on the focus plot. 

Toggle Chan – 4: Shows/hides Channel 4 on the focus plot. 

Only Chan-1: Shows only Channel 1 on the focus plot. 

Only Chan-2: Shows only Channel 2 on the focus plot. 

Only Chan-3: Shows only Channel 3 on the focus plot. 

Only Chan-4: Shows only Channel 4 on the focus plot. 

Note: Whenever you click in 
a plot area, that plot receives 
the focus.  

Focus is indicated by a thin 
frame of highlight 
surrounding the plot area. 
Plot commands affect the 
focus plot, only. 
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The Multi-Plot Menu 

 
From the Multi-Plot menu, you can specify which signal you would like to display in the Multi-
Purpose Plot. 

Nothing: Causes no plot to be displayed in the Multi-Purpose Plot. 

Stimulus: Causes the current stimulus to be displayed in the Multi-Purpose Plot. 

Raw Input: Causes one or more channels of raw (unprocessed) input signal to be displayed in the 
Multi-Purpose Plot. 

Time/Freq: Performs an FFT on the incoming time-domain signal, producing frequency-domain 
response data. 

EEG: Causes one or more channels of EEG signal to be displayed in the Multi-Purpose Plot. EEG 
signals are created by applying the specified acquisition setup parameters (such as gain) to raw 
input signals. See Defining Acquisition Parameters on page 57 for more information. 

Running Average: Causes the running average to be displayed. 

Show Comparison: Causes the currently defined comparison plot to be displayed superimposed 
with the running average. Running Average must be selected in order to view the comparison plot. 
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The History Menu 

 
From the History Menu, you can load history records and perform various operations on records 
displayed in the History Plot. 

Access Record File: Loads previously saved BioSigRZ records from files known as BioSigRZ 
record files. These files use the default extension, .arf. BioSigRZ records are displayed in the 
History Plot Area. 

Previous Group: Scrolls the History Plot to the top of the previous group. 

Next Group: Scrolls the History Plot to the top of the next group. 

To Top: Scrolls the History Plot to the top. 

To End: Scrolls the History Plot to the bottom. 

Clear Selection: Clears all selected records from the History Plot. 

Clear All: Clears all records from the History Plot. 

Edit Cursors: Accesses the BioSigRZ Cursor Edit dialog box. From this dialog box, you may 
place cursors and obtain signal information. 

Toggle Comparison: Marks the most recently selected history record for use as a comparison 
when viewing records details from the history area. 

To WorkSheet: Allows you to place the most recently selected history record in the Worksheet. 

Export to ARF File: Saves the currently selected history records in a user-defined BioSigRZ 
record file (.arf file). 

Export to ASCII File: Saves the currently selected history records in a user-defined ASCII file 
(.txt file). 

Export to CSV: Saves the currently selected history records in a user-defined CSV file. 

Show Cursors: Displays any cursors placed in History Plot records. 

Pile Channels: Overlays multiple channel history data. 

AutoCursor: Applies the selected auto cursor to the selected history record. See Auto Cursors on 
page 73 for more information. 
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The Worksheet Menu 

 
Clear Worksheet: Clears the entire Worksheet. 

Open Worksheet: Opens a Worksheet file (.awf file). 

Save Worksheet: Saves an existing Worksheet file. 

Save Worksheet As: Save a new Worksheet file. 

Export to Ascii: Saves the currently selected records in a user-defined ASCII file (.txt file). 

Export to CSV: Saves the currently selected records in a user-defined CSV file. 

Configure 

Worksheet Defaults: Allows you to set Worksheet preferences such as colors, plot size, 
and grid resolution. 

Trace: Displays a message describing how to edit a trace. 

Token: Displays a message describing how to edit a token. 

Space Evenly: Spaces selected plots evenly throughout the Worksheet. 

Spread Apart: Spreads selected plots apart. Spread Apart may be used repeatedly. Each use 
continues to further spread apart all selected plots. 

Squash Together: Squashes selected plots together. Squash Together may be used repeatedly. 
Each use continues to further squash together all selected plots. 

Pile: Piles selected plots on top of one another. 

UnPile: Unpiles selected plots. 

Delete: Deletes the currently selected Worksheet records. 

Select All: Selects all Worksheet records. 

Deselect All: Deselects all Worksheet records. 

Toggle Comparison: Marks the most recently selected worksheet record for use as a comparison 
in the worksheet. 
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The Calculator Menu 

 
The Calculator Menu provides mathematical operations that may be applied to one or more 
records displayed in the Worksheet. 

Scale: Multiplies each point in the selected Worksheet record(s) by a specified constant. 

Invert Trace: Multiplies each point in the selected Worksheet record(s) by -1. 

Shift Baseline: Creates a DC offset by adding a specified constant to each point in the selected 
Worksheet record(s). 

Remove Baseline: Removes the DC offset. 

Zero Points: Sets all points within a specified time range to zero. 

Crop Trace: Crops the selected trace from the specified starting point (ms) to the specified ending 
point (ms). 

Add: Adds two or more Worksheet records. 

Subtract: Subtracts one Worksheet record from another. 

Average: Computes the average of two or more Worksheet records. 

Time Align: Aligns all selected records with the first record in the selected group. 

Time Shift: Shifts the selected Worksheet record(s) along the time axis. 

Smooth: Applies a smoothing algorithm to the selected Worksheet record(s). 

Lowpass Filter: Applies a low-pass filter to the selected Worksheet record(s). 

Highpass Filter: Applies a high-pass filter to the selected Worksheet record(s). 

Bandpass Filter: Applies a band-pass filter to the selected Worksheet record(s). 

Notch Filter: Applies a notch filter to the selected Worksheet record(s). 

Hanning Window: Generates a Hanning window for use with the magnitude spectrum. 
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Cosine^2 Window: Generates a Cosine2 window for use with the magnitude spectrum. 

Mag Spectrum: Does a FFT and generates a magnitude spectrum of the data. 

AutoCursor: Applies the selected auto cursor to the selected worksheet record. 

The Help Menu 

 
From the Help Menu, you can access the About BioSigRZ dialog box. Clicking the BioSigRZ 
Help option or pressing the F1 button at any time prompts the BioSigRZ Manual.  
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Using the Toolbars 

The Toolbar 
On the BioSigRZ Toolbar, you can find quick point-and-click access to the most common 
commands.     

Click  To 

 
New  Clear all plots and reset BioSigRZ to its default 

configuration. 

 
Open Open an existing BioSig file. 

 
Save Save a BioSig file. 

 
BioSig Records Load records stored in a .arf file. 

 
Worksheet Records Load an .awf file. 

 
Setup Stimulus Define stimulus parameters. 

 
Setup Acquisition Define acquisition parameters. 

 
Modify SigGen 
Variables 

Modify the Stimulus Schedule and variables. 

 
Calibrate Open Calibration menu. 

 
General Display Configure general display fonts and colors. 

 
Worksheet Display Configure Worksheet display fonts and colors. 

 
Setup #1 Switch the screen layout to #1. 

 
Setup #2 Switch the screen layout to #2. 

 
Setup #3 Switch the screen layout to #3. 

 
Default Layout Auto adjusts the current layout to the default layout. 

 
Lock Lock the screen layout. 

 
Print Print the current history plot. 

 
About BioSigRZ Access about BioSigRZ dialog. 

 
Context-Sensitive Help Context-sensitive help is not currently supported. 
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The Plot Control Toolbar 
The multi-purpose and history plots are controlled through the use of the Plot Control Toolbar. 
This toolbar is normally invisible.  

The Plot Control Toolbar may be used to control the plot area that currently has the focus.  

Note: Whenever you click in a plot area, that plot receives the focus. Focus is indicated by a thin 
frame of highlight surrounding the plot area. Plot commands affect the focus plot, only. 

To display the Plot Control Toolbar: 

 Place the mouse pointer within the plot area and hold down the right mouse button.  
 
The Plot Control Toolbar will remain displayed while the right mouse button remains 
depressed. 

 

To click a Plot Control Toolbar button: 

1. With the right mouse button depressed, place the mouse pointer above the desired toolbar 
button. 

2. Release the right mouse button.  
 
The button will be clicked. With the release of the right mouse button, the Plot Control 
toolbar will disappear. 

Common Plot Control Toolbar Features 

 
Scaling  Customization  Channels 

The Plot Control Toolbar is customized for each BioSigRZ plot. However, there are certain 
common features found in all Plot Control Toolbars. Each toolbar consists of the following 
sections. 

o Scaling Section 

o Customization Section 

o Channels Section 

Scaling Section 
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Located on the far left of the Plot Control Toolbar, the scaling section consists of three buttons 
that may be used to alter plot scaling. These scaling commands may also be accessed from the 
View Menu. 

Scaling buttons are mutually exclusive. That is, clicking one scaling button turns that function 
“on” and turns all other scaling functions “off.”  “On” buttons appear depressed. 

Auto-Scale 

When Auto-Scale is chosen, BioSigRZ will automatically scale the plot that currently has the 
focus. 

To enable Auto-Scale: 

1. Display the Control Plot Toolbar. 

2. Click the Auto-Scale  button or press * on the numeric pad. 

Expand Scale 

Choosing Expand Scale causes the scale of the focus plot to expand. You may continue to expand 
the scale by repeatedly choosing Expand Scale. 

 

To expand the scale: 

1. Display the Control Plot Toolbar. 

2. Click the Expand Scale  button or press + on the numeric pad. 

Reduce Scale 

Choosing Reduce Scale causes the scale of the focus plot to be reduced. You may continue to 
reduce the scale by repeatedly choosing Reduce Scale. 

 

To reduce the scale: 

1. Display the Control Plot Toolbar. 

2. Click the Reduce Scale   button or press - on the numeric pad. 
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Customization 
Each plot area has its own specialized plot control functions. Buttons controlling these functions 
are found in the center of the Plot Control Toolbar. See The Multi-Purpose Plot below and The 
History Plot on page 45 for more information.  

Channels 

 
You may wish to display some or all channels in the current plot. Located on the far right of the 
Plot Control Toolbar, the channels section consists of four buttons that may be used to show/hide 
channels. These channel commands may also be accessed from the View Menu. 

Channel buttons are independent. That is, more than one channel button may be “on” at one time. 
Channel buttons act like toggle switches. Clicking a button that is “on” turns it “off.”  Clicking a 
button that is “off” turns it “on.”  As with Scaling buttons, “on” buttons appear depressed. 

Channels are indicated in Roman numerals, I, II, III, and IV. 

To show/hide a channel: 

1. Display the Control Plot Toolbar. 

2. Turn the channel “on” or “off” by clicking its button. 

Note: If none of the channel buttons are turned “on,” no plot will be displayed. The plot area will 
appear blank.  

Multi-Purpose Plot 

 
The Multi-Purpose Plot may be used to display a variety of signals during stimulus presentation 
and data averaging. The plot is controlled through the use of the Plot Control Toolbar.  

As with all other plots, you can control the scaling and channel display through use of the Plot 
Control Toolbar. Functions specific to the Multi-Purpose Plot are found in the center of the 
toolbar. These functions may also be accessed from the Multi-Plot menu. 

Types of Displays 

 
The buttons located in the center of the Plot Control Toolbar control the Multi-purpose signal 
display. The Multi-purpose Plot may be used to display the following signals: 

 Stimulus  

 Raw A/D 

 Frequency Domain 

 EEG 

 Running Average 

 None 
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Plot display buttons are mutually exclusive. That is, clicking one display button turns that function 
“on” and turns all other display functions “off.” “On” buttons appear depressed. 

Stimulus 

 
Choosing Stimulus causes the current stimulus signal to be displayed. BioSigRZ allows up to two 
channels of stimulus output.  

To display the Stimulus signal: 

1. Display the Control Plot Toolbar. 

2. Click the Stimulus Signal  button or press ‘S’ on the keyboard. 

Raw A/D 

 
Choosing Raw A/D Input causes unprocessed A/D input to be displayed. Raw input is not affected 
by currently defined acquisition setup parameters such as gain but will display the effects of 
acquisition filter settings. 

To display the raw A/D signal: 

1. Display the Control Plot Toolbar. 

2. Click the Raw A/D Input   button or press ‘I’ on the keyboard. 

Frequency Domain 

 
Choosing Frequency Domain causes the Raw A/D input to be displayed in the frequency domain. 
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To display the frequency-domain A/D signal: 

1. Display the Control Plot Toolbar. 

2. Click the Frequency Domain  button or press ‘T’ on the keyboard. 

EEG 

 
Choosing EEG causes processed input to be displayed. EEG data is affected by currently defined 
acquisition setup parameters such as gain and any acquisition filter settings that are applied. 

To display the EEG signal: 

1. Display the Control Plot Toolbar. 

2. Click the EEG  button or press ‘E’ on the keyboard. 

Running Average 

 
Choosing Running Average causes the current averaged EEG signal to be displayed. 

To display the running average: 

1. Display the Control Plot Toolbar. 

2. Click the Running Average  button or press ‘A’ on the keyboard. 

None 
Choosing None causes no signal to be displayed and the plot area will appear blank.  

To display no signal: 

1. Display the Control Plot Toolbar. 

2. Click the Display None  button or press ‘N’ on the keyboard. 
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The History Plot 

 
The History Plot is used to display historical averaged signal data. The plot is controlled through 
the use of the Plot Control Toolbar.  

You can control the scaling and channel display through use of the Plot Control Toolbar. 
Functions specific to the History Plot are found in the center of the toolbar. These functions may 
also be accessed from the History menu. 

Scrolling Functions 

 
History Plot data is organized into groups. Each time you tell BioSigRZ to begin collecting data, it 
begins a new group. Data records are appended to the end of the group until you halt data 
collection. When data collection is resumed, a new group is appended to the end of the History 
Plot. 

You may quickly scroll to the top or bottom of a group using the scrolling buttons. 

To scroll to the top of the previous group: 

1. Display the Control Plot Toolbar. 

2. Click the Scroll Up  button or press Page Up on the keyboard. 

To scroll to the top of the next group: 

1. Display the Control Plot Toolbar. 

2. Click the Scroll Down  button or press Page Down on the keyboard. 

Editing Functions 

 
You may edit the History Plot using the editing buttons. You may perform editing functions on all 
records or just those that are selected. Selected records appear surrounded by a frame of highlight. 

Selecting Records 
You may select one record, multiple contiguous records, or multiple non-contiguous records for 
editing using standard, Shift+click and Ctrl+click Windows® methods. 

Editing 

To clear selected History Plot records: 

1. Display the Control Plot Toolbar. 

2. Click the Clear Selected Record  button. 
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To clear all History Plot records: 

1. Display the Control Plot Toolbar. 

2. Click the Clear History  button or press Ctrl-X. 

Note: BioSigRZ maintains a file of historical records knows as the BioSigRZ record file (.arf file). 
As history records are acquired, they are appended to this file. Clearing a record from the History 
Plot does not remove the record from the BioSigRZ record file. Records stored in the BioSigRZ 
record file can be retrieved and viewed in the History Plot by choosing Access Record File from 
the History menu. 

The Calculator and Worksheet Buttons 

 
BioSigRZ provides mathematical functions that may be applied to one or more Worksheet 
record(s). These functions may be accessed from the Calculator menu or from buttons displayed in 
the area of the main window known as the Calculator.  

Calculator functions are described in detail in a later section. For more information about the 
Calculator, see Using the Calculator on page 106. 

Calculator Functions 
 

Button Menu Option Action 

 

Scale Multiplies each point in the selected Worksheet record(s) by a 
specified constant. 

 

Invert Trace Multiplies each point in the selected Worksheet record(s) by -1. 

 

Shift Baseline Creates a DC offset by adding a specified constant to each point 
in the selected Worksheet record(s). 

 

Remove 
Baseline 

Removes the DC offset. 

 

Zero Points Sets all points within a specified time range to zero. 

 

Crop Select a crop point for the selected record. 

Calculator Buttons 

Worksheet Buttons 
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Calculator Functions (Continued) 
 

Button Menu Option Action 

 

Add Add two or more Worksheet records. 

 

Subtract Subtracts one Worksheet record from another. 

 

Average Computes the average of two or more Worksheet records. 

 

Time Align Lines up selected Worksheet records along the time axis. 

 

Time Shift Shifts the selected Worksheet record(s) along the time axis. 

 

Smooth Applies a smoothing algorithm to the selected Worksheet 
record(s). 

 

Lowpass Filter Applies a low-pass filter to the selected Worksheet record(s). 

 

Highpass Filter Applies a high-pass filter to the selected Worksheet record(s). 

 

Bandpass Filter Applies a band-pass filter to the selected Worksheet record(s). 

 

Notch Filter Apply a notch filter to the selected Worksheet record(s). 

 

Hanning 
Window 

Applies a Hanning window to the selected worksheet record for 
use with the magnitude spectrum. 

 

Cosine^2 
Window 

Applies a Cos2 window to the selected worksheet record 
(smoothes the start and end). Used with magnitude spectrum. 

 

Mag Spectrum Generates an FFT of the data using 1024-8192 points per FFT. 

 

Auto Cursor Applies the selected auto cursor to the selected worksheet 
record. 
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Worksheet Functions 
Located below the Calculator, the five Worksheet buttons can be used to format and organize the 
Worksheet. These functions may also be found in the Worksheet menu. 

Button Menu Option Action 

 

Space Evenly Spaces all selected plots evenly throughout the 
Worksheet. 

 

Spread Apart Spreads all selected plots apart.  

 

Squash Together Positions selected plots closer together. 

 

Pile Piles all selected plots on top of one another. 

 

UnPile Unpiles all selected plots. 

 

Delete Deletes the currently selected Worksheet records. 

The Worksheet 

 
The Worksheet is an area of the main window where you can place records for reporting. 
Calculator functions may also be applied to records in the Worksheet. For more information about 
the Worksheet, see Using the Worksheet on page 99.  
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Customizing Your Display 

BioSigRZ is designed to provide various types of visual data on one easy-to-use main window. 
Depending on your data display needs and your type of monitor, you may find it useful to alter the 
default BioSigRZ screen configuration. Some common screen configuration problems and their 
solutions are listed below. 

Problem Solution 

Plot text seems too big or too small. Change the size of the font. 

Plots cannot be seen clearly against 
the plot background. 

Change the plot background color 
and/or the plot color. 

One or more plot is not large enough. Maximize the window and/or change 
one or more plot sizes. 

Multi-purpose plots cannot be 
differentiated from one another. 

Change one or more plot colors. 

To customize the Worksheet: 

 Select Worksheet Displays Ops from the Setup menu or click the Worksheet Display  
button.  
 
This prompts the Worksheet Display Options dialog box. 
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To customize all other areas: 

 Select General Displays Ops from the Setup menu or click the General Display  button. 
 
This prompts the General Display Options dialog Box. 
 

  
 

From either Display Options dialog box you may configure the font types and sizes and colors 
using standard Windows® techniques. 

Customizing the Layout 
You may wish to re-size screen display areas.  

To manually customize a screen area: 

 Drag one or more Sizing Bars until the desired size is reached. 

Using Setups 
You may configure up to three layout setups.  

To use a setup: 

 Select the desired Setup # by hovering over the Layout option in the Setup menu. 
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To configure a setup: 

1. Select the desired Setup # by hovering over the Layout option in the Setup menu or click the 

desired Setup #  button.  

2. Ensure that the desired Setup # is currently unlocked prior to any modifications. To do this, 

click the Lock  button if it is currently  enabled. 

3. Manually customize the layout. 

4. Select Lock by hovering over the Layout option in the Setup menu or click the Lock  
button. This layout is now associated with the chosen Setup #. 

Returning to the Default Layout 

To return to the default layout: 

1. Select To Default hovering over the Layout option in the Setup menu or click the Default 

Layout  button. 

Customizing Cursor Strings 
BioSigRZ provides a means for placing cursors in history/worksheet records. This process is 
known as Cursor Editing.  

When a history or worksheet record is selected for Editing, it is possible to place up to 10 cursors 
within the signal. Each cursor is associated with a text label. You may customize the first five 
labels. These labels are known as cursor strings. 

To customize a default cursor string: 

 Select Default Cursor Strings from the Setup menu. 
 
You will see the Default Cursor Text dialog box. 
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Cursor strings may be defined as follows: 

o One set for all acquisition channels. 

o One set for each acquisition channel. 

To specify one set of cursor strings for all acquisition channels: 

1. Check the One Set Only check box. 

2. Type in the desired cursor strings. 

3. Click OK. 

To specify one set of cursor strings for each acquisition: 

1. Make sure the One Set Only check box is not checked. 

2. Select the desired acquisition channel. 

3. Type in the desired cursor strings. 

4. Click OK. 

5. Repeat for each acquisition channel. 

 

 



 

Chapter 3   Configuration 

Prior to presenting a stimulus signal and acquiring response data, stimulus and data acquisition 
parameters must be configured. These parameters are saved as part of the BioSigRZ configuration 
file. The information in this section can be used to modify an existing configuration or to create a 
new configuration file. 

Opening and Saving Configuration Files 

To open an existing BioSigRZ file: 

1. Click Open Config. File from the File menu or click the Open  button.  

2. Click on the desired file. 

3. Click Open.  

To save a new file in BioSigRZ format: 

 Select Save Config As from the File menu. 
 
The Save As dialog box will be displayed. You may assign a name to your new configuration. 

To save an existing file: 

 Select Save Config. from the File menu or click the Save  button.  
 
The file will be saved with its current name. 

Creating Configurations 
When creating a new configuration file, it is necessary to complete the steps below prior to 
presenting a stimulus signal and acquiring response data. 

o Define stimulus signal parameters. 

o Define data acquisition parameters.  

Optionally the user might also wish to: 

o Review the calibration. 

o Specify the stimulus schedule. 

o Modify the Target Device setup. 

Defining Stimulus Parameters 

Stimulus parameters are defined from the Stimulus Setup dialog box. 

To access the Stimulus Setup dialog box: 

 Select Stimulus from the Setup menu or click the Setup Stimulus  button. 
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Defining the Stimulus 

 
You may define a single channel stimulus. Dual channel stimulation is available in the DPOAE 
standard configuration. For custom dual channel stimulation contact TDT. 

Specifying the SigGenRZ File 
BioSigRZ generates a stimulus signal based on signal parameters read from previously defined 
SigGenRZ signal files (.sig files). To define a stimulus signal, the user specifies the desired .sig 
file. 

To specify the stimulus file: 

1. Click the Browse  button to the right of the Primary File field. 

2. Select the desired file. 
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or 

 Type in the desired file name in the Primary File field. 

Stimulus Refresh 
BioSigRZ generates a stimulus signal based on the parameters specified in the SigGenRZ file. The 
generated signal is stored in a buffer. This buffered signal is then presented as a stimulus. A 
stimulus refresh occurs whenever the signal currently stored in the buffer is replaced with a freshly 
generated stimulus signal. 

In theory, a stimulus signal could be refreshed: (1) prior to each presentation or (2) prior to a new 
set of stimulus variable conditions, called a SigGen Index or SGI. 

In practice, however, the ability to perform a stimulus refresh is limited by processing 
considerations. The real time processing of incoming response data must take precedence over the 
refresh of the stimulus signal. BioSigRZ performs a stimulus refresh as follows: 

o The stimulus signal is always refreshed prior to a new SGI. 

This automatic refresh is necessary in order to reflect any changes in stimulus signal 
parameter values associated with the new SGI. 

o The stimulus signal may be refreshed when possible within an SGI. This option is 
enabled by checking the Freshen when possible checkbox. 

Refreshing Non-Noise Stimuli. Within an SGI, non-noise stimulus signals, such as clicks and 
periodic waveforms, remain constant. These signals need only be refreshed prior to a new SGI. 
For these signals, do not check Freshen when possible. 

Refreshing Noise Stimuli. It may be desirable to refresh noise stimuli. While BioSigRZ cannot 
guarantee that a noise signal will be refreshed for every presentation within an SGI, it will attempt 
to refresh the signal when possible. If the Freshen when possible option is chosen, the noise 
stimulus will be refreshed whenever there are no processing demands being made by incoming 
data. If you wish the noise stimulus to remain constant throughout all presentations in a given SGI, 
do not specify Freshen when possible. 

To refresh the stimulus whenever possible: 

 Check the Freshen when possible check box. 

Locking SigGen Files 
You may modify SigGenRZ variables from within BioSigRZ.  

If the Lock SigGen Files checkbox is enabled, changes you make to the SigGenRZ variables 
within BioSigRZ will be saved with the .acf file. Any changes to the .sig file that are done outside 
of BioSigRZ will have no effect on the configuration, because BioSigRZ has 'locked' a copy of the 
SigGen file inside of the .acf file.  

If the Lock SigGen Files checkbox is unchecked, the SigGen file is reloaded from disk every time 
you open the .acf file and your changes to the variables within BioSigRZ will be overwritten and 
lost. 

To lock a SigGen File for the current .acf: 

 Check the Lock SigGen Files check box. 

Reloading the SigGenRZ Stimulus File 
SigGenRZ files are automatically loaded: 

o When the file name is specified (see below). 

o When an existing BioSigRZ configuration file (.acf file) is loaded. 
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SigGenRZ files may also be manually loaded by: 

o Browsing to the desired SigGenRZ file. 

Included in the SigGenRZ file is information defining how variables will change as a function of 
the SGI. Once a SigGenRZ file has been loaded, this information is available to the BioSigRZ 
application and will be saved in the BioSigRZ configuration file (.acf file).  

In some cases, it may be necessary to modify these stimulus variables. BioSigRZ allows you to 
make local changes to stimulus variables for Channel 1, only. (Note that with a two channel 
system, both SigGenRZ files should have the same variables. BioSigRZ only implements 
variables in the file for Channel 1.)  

Reload File: When you reload a SigGenRZ file with variables, the variable schedule currently 
defined in BioSigRZ will be replaced with the schedule stored in the SigGenRZ file. 

To reload a SigGenRZ file: 

 Click the Reload File button. 

Presentation Timing 

 
Temporal parameters associated with the presentation of the stimulus signal are defined in the 
Presentation Timing section of the Setup Stimulus dialog box. 

The Presentation parameters consist of the following: 

o Presentation Rate (stimuli/second)  

o Presentation Period (milliseconds) = 1000/Presentation Rate (sec) 

o Ext. Trigger  - Not supported at this time 

o Continuous - Enable/disable continuous presentation.  

Presentation Rate 
You may define the Presentation Rate by entering a value in the Presentation Rate field. When you 
leave this field, the value of the Presentation Period field will be calculated automatically. 

Presentation Period 
You may define the Presentation Period by entering a value in the Presentation Period field. When 
you leave this field, the value of the Presentation Rate field will be calculated automatically. 

When Continuous is enabled (see below), the presentation period is automatically defined as the 
length of the SigGenRZ signal assigned to stimulus channel 1. When continuous is enabled, you 
may not edit the Presentation Rate or Presentation Period. 

Note: When Continuous is not enabled, the Presentation Period must be 1.25 times longer than the 
stimulus and acquisition duration.  
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Ext. Trigger 
This feature is not currently supported at this time. 

Continuous 
When Continuous is checked, the stimulus will be played continuously. Upon reaching the end of 
the signal, BioSigRZ will loop back to the beginning of the buffer and replay the signal. This cycle 
will continue throughout continuous signal play.  

Note: When selecting continuous record the assigned SigGenRZ file must be designed for 
continuous stimulus presentation. 

Speaker Calibration 

 
Calibration associated with the presentation of the stimulus signal can be loaded in the Speaker 
Calibration section of the Setup Stimulus dialog box. 

To load a Calibration file: 

1. Click the Browse  button. 

2. Select the desired file or type in the desired file name in the text field. 

A text area displays specific information regarding the currently selected calibration file including 
the transducer, amplifier, gain setting, and any additional notes.  

The Gain value tells you what value to set the manual attenuator on the RZ6. For example, a gain 
value of -6dB indicates that this calibration file was created with the manual attenuator knob set to 
6dB, so in order for this calibration to be accurate you must set the manual attenuator knob to 6dB. 

Note: Calibration files are provided for common speakers and use the extension .tcf. Additional 
calibration files can be downloaded online at: http://www.tdt.com/support.htm  

Defining Data Acquisition Parameters 

Data Acquisition parameters are defined from the Acquisition Setup dialog box. 

To access the Acquisition Setup dialog box: 

 Select Acquisition from the Setup menu or click the Setup Acquisition  button. 

http://www.tdt.com/support.htm�
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Response Record File 
Response record files, or history record files, (.arf) are continuously maintained during data 
acquisition. Each averaged record is appended to the history record file. 

Name: This will be the default history record file name. 

Prompt for File Name: When this box is checked, BioSigRZ will always prompt you for a file 
name before stimulus presentation begins, allowing the option to specify separate .arf files.  

Timing 
Onset Delay: The value in the Onset Delay field defines the time delay in milliseconds from the 
time of stimulus onset to the beginning of response signal acquisition. This field is set to zero and 
disabled when continuous signal presentation is enabled. 

SG Variable: Onset delay may be defined as a constant or as a SigGenRZ variable. This box is 
disabled when continuous signal presentation is enabled. 

Duration: The value in the Duration field specifies the length in milliseconds of the acquired 
response signal. When continuous signal presentation is enabled, this value will default to the 
duration of the SigGenRZ signal and the field will be disabled. 

Sub-Folds: You may divide the acquired signal into subunits that are folded onto each other. 
These sub-folds are added to one another. The resulting composite signal is averaged. For 
example, if an acquired signal of 50 milliseconds is assigned 2 sub-folds, the result is two 25 
millisecond sub-folds. The first 25 millisecond sub-fold will be added to the second 25 
millisecond sub-fold. Sub-folds may be used with both non-continuous and continuous signals. 

Zero Onset: Zero Onset defines a duration beginning at 0 milliseconds during which the acquired 
signal will be set to zero. For example, if Zero Onset is defined as 20 milliseconds, the first 20 
milliseconds of the acquired signal will be set to zero. 

Sample Period: This field displays the current sample period in microseconds associated with the 
acquisition sampling rate (this rate is defined in the assigned .sig file and cannot be edited). 

Setup Inputs 
Once an input source (such as the RZ6 device A/D or RA4PA Bioamp) is selected, you may 
define configuration parameters for the acquisition channel.  
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To setup an acquisition channel:  

 Click the desired acquisition channel button. The Acquisition Channel Setup dialog box 
opens. 

 

Configuration 
No. Averages: The value of Number Averages determines the number of response signals 
acquired and averaged for every SGI. Number Averages must be at least 1 and cannot exceed 
3000. 

Gain: The value specified in the Gain field can be used to adjust the voltage of the acquired data 
signal. This optional setting is useful if you wish to manually calibrate your device input. In most 
cases this value will be left at 1 and a calibration file will be used. Refer to Example 1, page 13 for 
more information on how to calibrate the configuration for an amplifier and headstage.  

TDT recommends visiting http://www.tdt.com/support.htm to download calibration files for 
common microphones, preamplifiers, and headstages. 

Preprocessing 
AC Couple: Checking this box enables AC Coupling. AC Coupling removes the DC component 
by subtracting the signal average. 

Note: At this time only one 
acquisition channel is 
supported using the standard 
RPvdsEx circuit file provided 
with BioSigRZ (see page 64 
for more information). 
Contact TDT if you need 
more than one acquisition 
channel. 

http://www.tdt.com/support.htm�
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Artifact Rejection 
In some cases, anomalous amplitude values may indicate an artifact in the acquired data signal. 
BioSigRZ provides a means for detecting and rejecting signals with such artifacts, Artifact 
Rejection. By enabling Artifact Rejection, you can specify at which peak amplitude you wish to 
reject an acquired signal. This amplitude is specified as a percentage of the threshold relative to 
the maximum voltage input (±10 Volts or input signal).  

Note: Signals rejected through Artifact Rejection are not included in the average for each SGI. 

To enable Artifact Rejection: 

1. Check Enabled in the Artifact Rejection area. 

2. Enter the desired percentage in the Threshold field. 
 

 
or 

1. Select the Raw A/D Input in the Multi-Purpose Plot. 

2. Place the mouse pointer in the plot. 

3. Hold down the left mouse button and Ctrl. A threshold line appears.  
 

  
4. Drag until the desired artifact rejection is reached. The threshold percentage will be displayed 

in the Mode field. 

Enabling/Disabling a Channel 
Acquisition Channel 1 is always enabled. Channel 2 is disabled by default and is not supported by 
BioSigRZ at this time. However, if the system has been modified to use two channels, Channel 2 
can be enabled or disabled. Contact TDT for more information if two channels are required.  

Important!: Enabling channel 2 in BioSigRZ will not enable acquisition on a second channel 
unless the circuit file has been modified. Contact TDT for assistance. 

For systems running custom circuit files: 

To enable Acquisition channel 2: 

1. Click the Chan-2 [ ] button. 

2. Click OK. 

To disable Acquisition channel 2: 

1. Click the Chan-2 [X] button 

2. Click Disable. 
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Once you have enabled or disabled a channel, you will be returned to the Acquisition Setup 
screen. By examining the Edit Acquisition Channels buttons, you can quickly determine 
which channels are enabled. Enable channels display [X] on their buttons. 

Post Processing 
You may apply various types of post-processing to the acquired signal.  

To apply post processing: 

 Click the Post Processing button. 

You will see the Post Processing dialog box. From this box you may enable a variety of post 
processing options. 

 
Hanning Window: Applies a Hanning window to the acquired signal.  

Truncate to Rad-2: Truncates the number of data points to radix 2. 

Mag Spectrum (dB): Displays intensity in the logarithmic units of decibels. 

Phase Spectrum (rads): Displays the phase spectrum in radians. 

Microphone and Device Input Calibration 

 
Calibration associated with the acquisition of the stimulus signal (such as preamplifiers, 
headstages, or microphones) can be loaded in the Microphone Calibration section of the 
Acquisition Setup dialog box.  
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To load a Calibration file: 

1. Click the Browse  button. 

2. Select the desired file. 
 
or 

 Type in the desired file name in the text field. 

A text area displays specific information regarding the currently selected calibration file including 
the transducer, headstage, amplifier, gain setting, and any additional notes. 

The Gain value tells you what value to set the microphone Gain knob on the RZ6. For example, a 
gain value of 40dB indicates that this calibration file was created with the microphone Gain knob 
set to 40 (and the Gain switch set to "Amp"), so in order for this calibration to be accurate you 
must set the Gain knob on the RZ6 to 40dB. 

Note: Calibration files are provided for common microphones, headstages, and preamplifiers and 
use the extension .tcf. Visit http://www.tdt.com/support.htm for a list of calibration files. 

Reviewing Calibration 

In most cases calibration is not required; however, calibration can be reviewed using the 
calibration dialog.  

To view the current calibration: 

 Select Calibration from the Setup menu or click the Calibration  button.  

 

http://www.tdt.com/support.htm�
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SigGen Specifications: Specifies the calibration defined in the currently loaded .sig file. 

Speaker Calibration: Lists the details of the currently configured calibration file (.tcf) loaded 
in the Stimulus Setup dialog. See page 57 for more information. 

Use Acquire Spec: When checked, the details of the calibration file (.tcf) currently specified 
in the Acquisition Setup dialog will be displayed in the Microphone Calibration text area 
below. If unchecked you may specify a different microphone calibration file to be used with 
the Probe Tone test. This does not change the Acquisition Setup for your experiment 
configuration. 

Microphone Calibration: Lists the details of the currently configured calibration file (.tcf) 
loaded in the Acquisition Setup dialog. See page 61 for more information. 

Probe Tone: Present a probe tone to test connected equipment. 

 Freq(Hz): Specify the frequency for the probe tone. 

Level (vrms): Specify the level of the probe tone. Typically 1 V is used (all examples are 
calibrated to 1 Vrms = 90 dB).  

Probe Tone Dial: Click and drag to the desired output channel to enable the probe tone 
presentation. The large dial at the bottom of the dialog will display the measured sound level 
in dB SPL recorded by the microphone. 

Specifying the Stimulus Schedule 

When the stimulus is defined, either by loading a standard configuration file or by specifying a 
stimulus file in the Stimulus Setup dialog, a complete list of signal parameters and variables are 
added to the BioSigRZ file. During stimulus presentation, the values of the variables change as a 
function of the SGI (a set of variable conditions). This is called the stimulus schedule. Both the 
stimulus schedule and the variable definitions can be modified in BioSigRZ. 

Viewing the Current Stimulus Schedule 

To view the current stimulus schedule: 

 Select Modify Schedule from the Operations menu. In addition, you can also select SigGen 

Variables from the Setup menu or click the Modify SigGen Variables  button. 

This prompts the SigGen Variable Control dialog. 
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The SigGenRZ Variable Control dialog box displays the current stimulus schedule. Variable 
values are shown for each SGI.  

You may scroll through the stimulus schedule as follows: 

To scroll up and down 

 Use the Vertical Scroll Bar. 

To scroll to the right 

 Click the  button. 

To scroll to the left 

 Click the  button. 

Once you have viewed the stimulus schedule, you may: 

o Accept the current stimulus schedule. 

o Modify the current stimulus schedule. 

o Modify variables. 

To accept the current stimulus schedule: 

 Click OK. 
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Modifying the Stimulus Schedule 

You may wish to present a subset of the current stimulus schedule. To do so, just select the SGIs 
to be included in the subset for presentation. When no SGIs are selected, BioSigRZ will present 
the entire stimulus schedule. Otherwise, BioSigRZ will present only the selected SGIs. 

To select a single SGI: 

 Click the desired SGI. 

To select multiple, non-contiguous SGIs: 

 Ctrl+Click the desired SGIs. 

To select a group of contiguous SGIs: 

1. Place the mouse pointer over the first SGI. 

2. Hold down the left mouse button. 

3. Drag the mouse pointer to the last SGI. 

4. Release the left mouse button.  
or 

1. Click the first SGI. 

2. Shift+Click the last SGI. 

To select all odd SGIs: 

 Click the Do Odd button. 

To select all even SGIs: 

 Click the Do Even button. 

To deselect a single SGI: 

 Ctrl+Click the desired SGI. 

To deselect all SGIs: 

 Click the Clear Selections button. 

Modifying Variables 

Variables change the signal parameters as a function of the SigGen Index (SGI) and are defined 
within SigGenRZ and can be modified in BioSigRZ through the use of the Signal Variable 
dialog.  

Note: When using dual channel stimuli such as in the standard DPOAE configuration, changes to 
signal variables will affect channels 1and 2. Variables may also be altered in SigGenRZ. 
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To access the Signal Variable dialog box: 

 Click the name of the variable you wish to change in the SigGen Variable dialog. 

The Signal Variable dialog box available in BioSigRZ is much the same as the dialog used to 
define variable in SigGenRZ. This section provides information about the settings most pertinent 
to modifying variables from within SigGenRZ. For more information on all settings, see the 
SigGenRZ Manual.  
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Name and Units 
In general, the variable name and units should not be changed in BioSigRZ. 

Commonly used Variable Methods 
Method defines the mechanism (function) of altering variable values as a function of the SigGen 
Index (SGI). 

  
See the SigGenRZ Manual for more information on the available variable methods. Some of the 
more commonly used Variable methods include: 

Constant 

This method sets the variable equal to a constant value. This method is most useful when more 
than one parameter will be set to the same value. Constant defines a variable that will always have 
the same value as given in the Default/Start field of the Value Limits box. This value will be a 
floating-point constant between 1.2E-38 to 3.4E+38. 

Linear Step 

For each SigGen Index (SGI) increment, Linear Step defines a variable that will increment by the 
Step value specified in the Value Limits box. 

Alternating 

The value of the variable alternates between the values defined in the Minimum and Maximum 
fields. The variable value does not depend on SGI value, but on the number of the continuous 
presentation of the current signal interval. In the Variables group box, an alternating variable must 
be defined next to another predefined variable, or as the first variable. 

Value List 

Variable values are specified in SigGenRZ during the signal design process. A maximum of 80 
variable values can be specified for the variable. 

To enter or modify a variable list: 

1. Select Value List from the Method drop-down box. 

2. Click the Edit List button. 
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3. Enter values to define the variable.  
 

 
4. Click OK. 

 

Combination Variables 
In some cases, a simple variable is not sufficient to define a signal. A combination variable is a 
variable whose value is calculated by performing a mathematical operation on another variable or 
a constant.  

  

To Define a Combination Variable: 

1. Open the Signal Variable dialog, either by selecting SigGen Variables from the Setup menu, 

or by clicking the SigGen Variables  button on the side bar. 

2. Name and define the combination variable in the General box. 

3. In the Combination Variable box select an Operation to apply to this variable (V in the 
Operation formula). Combination variables can be defined using addition, subtraction, 
multiplication, and division.  
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Operation: 
 

 
 

The Variable drop down menu in the Combination Variable box is used to define Vcomb in the 
operation. Vcomb can be defined as either a constant, and its value entered in the Value box, or it 
can be defined as another variable.  

When the stimulus signals that contain combination variables are used in BioSigRZ, the 
combination variable value is calculated and used in generating the signal and controlling the 
peripherals. 

Value Limits 
From the Value Limits group box you can define the manner in which a variable value changes as 
a function of the SigGen Index (SGI) value. You can also define the range of allowable values for 
the variable. For combination variables, these values will only apply to primary variable(s), and 
will not limit the combination variable result. However, a zero will be used when the combination 
variable result becomes a divide-by-zero. 

 

Default/Start 
Default/Start defines the value of the variable when the SigGen Index = 1. This is also the value 
for a constant variable. When prompt variables (Prompt Level 1, Prompt Level 2, Prompted File) 
and Dynamic variables are defined, this value is also the default variable value before the value is 
specified.  

Step Size 
Step determines how much the variable will be systematically varied as a function of the SigGen 
Index value. A zero Step Size for other functions will define a constant variable (except when the 
method is Randomized). 

Minimum 
In the Minimum field, you define the minimum allowable value for the variable. 
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Maximum 
In the Maximum field, you define the maximum value allowed for the variable.  

Note:  Minimum value must be smaller than Maximum, and Default/Start must be within 
Minimum and Maximum range. 

No. of Steps 
This field displays the total number of steps between the minimum and maximum variable values, 
when appropriate. This field is not editable. 

SGI Modifiers 
SigGen Index (SGI) is a unique number which starts at 1 and increments by 1 when an interval is 
presented. This SGI applies to every variable by means of SGI Modifiers. These SGI Modifiers 
become important when SigGenRZ is used to design signals with complicated variables or nested 
variables. 

By default, a stimulus presentation begins with the SGI = 1. Often, the stimulus signal generated at 
SGI = 1 is presented until a desired number of response signals have been attained. The SGI is 
incremented by 1 then all variables and the entire signal are updated. This process continues until 
all SGIs have been presented. Through use of SGI Modifiers, it is possible to customize the 
process of SGI incrementation for individual variables. You may: 

o Start variable calculation with an offset to SGI 

o Repeat SGI 

o Skip a specified number of SGIs 

o Create nested variables 

 

 

Offset 
The initial SGI is always 1. When SGI is used to calculate variables, any deviations from this 
default value are termed offsets. If you wish to start stimulus presentation with a variable 
calculated based on a modified SGI = n, then enter n in the Offset field. If the variable’s values are 
0, 1, 2, 3, 4, 5, ..., corresponding to SGI = 0, 1, 2, 3, 4, 5, ..., an Offset = 2 will result in modified 
SGI = 2, 3, 4, 5, 6, ..., and so the variable’s values 2, 3, 4, 5, 6, ..., correspond to SGI = 0, 1, 2, 3, 
4, 5, .... 

The default value of Offset is 0, that is, the modified SGI equals to SGI. The value of Offset must 
be no less than -10,000 and no greater than 10,000. 

Repeat Factor 
The Repeat Factor field specifies the number of times, r, an SGI will be used as modified SGI. For 
example, when r = 2, modified SGI will be 1, 1, 2, 2, 3, 3, ..., corresponding to SGI = 1, 2, 3, 4, 5, 
6, .... 

By default, Repeat Factor is set to 1 (use each SGI once). Repeat Factor may be no less than 1 and 
no greater than 100.  
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By using a Repeat Factor in tandem with a Termination Control specification of Loop (see next 
section), you can create nested variables. 

Skip Factor    
The Skip Factor field specifies the number of the SGIs is to be ignored in the modified SGI. For 
example, if Skip Factor is 2, modified SGI will be 1, 3, 5, 7, 9, ..., corresponding to SGI= 1, 2, 3, 
4, 5, 6, .... 

By default, Skip Factor is set to 1. Skip factor may be no less than 1 and no greater than 100. 

Termination Control 
You can control the termination of the SGI by choosing one of three types of termination control. 

 

Normal/None 
When Normal/None is chosen, the variable will not be considered in termination control. Thus, if 
a minimum or maximum variable value is reached, signal play will not terminate, nor will the 
variable value loop. The variable will instead remain at the minimum or maximum value. 
Continuous signal generation will be based on the final variable value. In this case, signal play 
will be terminated by other variables or manually. 

Boundary Control 
Boundary Control provides a method of experiment termination. When Boundary Control is 
chosen, the SigGen Index (SGI) will not be incremented if such an action would cause the value of 
the variable to be: 

o Less than the Minimum value 

o Greater than the Maximum value 

Such failure to increment the SGI produces differing results, depending on the application. 

When a boundary is reached and the SGI ceases to be incremented, signal generation will continue 
for the current SGI, but no more response data will be collected. 

Note:  Specification of Minimum and Maximum does not provide boundary control. Minimum 
and Maximum simply define the limits of parameter variation. The variable will not be allowed to 
go beyond either of these limits.  

Loop 
When Loop is chosen, parameters continuously loop through the series of variable values as SGI 
increments. 

See the SigGenRZ Manual for more information on the variable parameters contained in this 
dialog. 
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Modifying the Target Device Setup 

BioSigRZ is designed to run exclusively with the RZ6 Multi I/O processor. A standard RPvdsEx 
circuit file running at ~200 kHz is implemented by default and is suitable for most users.  
In those rare cases where a custom circuit file is required, the circuit file may be overridden in the 
Target Device Setup. Contact TDT for assistance if you wish to use custom circuit files. 

To access the Setup Target Hardware dialog box: 

Select Target Device from the File menu. 

Device Select  

Type 
BioSigRZ supports the RZ6 only.  

Index 
If a system comprises more than one RZ6 the index number can be used to specify which RZ6 to 
use.  

Circuit File Override 

Name 
If a custom circuit file (designed in RPvdsEx) is required. Type or browse to select the file name. 
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Once the configuration process has been completed, you are ready to present a stimulus and 
acquire data.  

Subject Definition 

You may wish to associate subject information with each group of signals added to the history 
plot. Such information may be defined in the Subject Information dialog box. 

To access the Subject Information dialog box: 

 Select Subject Info from the Setup menu. 

  
Subject ID: This subject identifier may be up to 15 characters in length. The Subject ID will be 
associated with all subsequently acquired data. The ID will be displayed in the history plot 
immediately above the history data. It will also be stored with the history data in the BioSigRZ 
record file (.arf file). 

Reference 1: This reference text may be up to 15 characters in length. The text of Reference 1 
will be associated with all subsequently acquired data. The character string will be displayed in the 
history plot immediately above the history data. It will also be stored with the history data in the 
BioSigRZ record file (.arf file). 

Reference 2: This reference text may be up to 15 characters in length. The text of Reference 2 
will be associated with all subsequently acquired data. The character string will be displayed in the 
history plot immediately above the history data. It will also be stored with the history data in the 
BioSigRZ record file (.arf file). 

Memo: This character string may be up to 49 characters in length. This text will be associated 
with all subsequently acquired data. The text will not be displayed in the history plot, but will be 
stored with the history data in the BioSigRZ record file (.arf file). Memo text can be viewed from 
BioSigRZ Cursor Edit dialog box. 

Auto-Cursors 

You may specify up to 10 auto-cursors. Auto-cursors are cursors that are automatically placed at 
specific points in the signal as the signal is acquired. Auto-cursor position is determined through 
specification of an auto-cursor equation. You may specify an auto-cursor equation from the 
Specify Auto-Cursor Equation dialog box. 
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To access the Specify Auto-Cursor Equation dialog box: 

 Select Auto-Cursors from the Setup menu. 

 

Select Cursor 
From the Select Cursor group box, you may choose to specify an auto-cursor equation for any of 
the first 10 cursors. 

To specify an auto-cursor: 

 Click the desired cursor number in the Select Cursor box. 

Specifying the Algebraic Equation 
Specifying the algebraic equation may be accomplished in three steps: 

o Enabling auto-cursors. 

o Specifying the equation. 

o Parsing the equation. 

Enabling Auto-Cursoring 

To enable auto-cursoring: 

 Check the Enable checkbox. 

Specifying the Equation 
You may now enter an auto-cursor equation in the Algebraic Equation field.  
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Auto-Cursor equations may include one or more SigGenRZ Variable. Instead of using the variable 
name, however, you must use a variable number. For example, if the variable you wish to use is 
level (the second variable in the BioSigRZ variable list) you would use V2. 

V2 + 100 

You may also use existing auto-cursors as variables in auto-cursor equations. Auto-cursor 
variables are specified by Cn, where n is the number of the auto-cursors. For example, if you wish 
to use auto-cursor #3 in an equation, use variable C3. 

C3 - V2 + 100 

Auto-cursors are placed in the time axis in time-domain waveforms and in the frequency axis in 
frequency-domain waveforms. Thus, the unit of measurement for time-domain auto-cursors is 
milliseconds, while the unit of measurement for frequency-domain auto-cursors is Hz. 

Parsing the Equation 
Once you have specified the equation, it must be parsed. During parsing, the equation is evaluated. 
Any errors noted during parsing will be reported. 

Note: All auto-cursor equations must be parsed. Failure to parse the equation will result in a 
failure to use the equation during data acquisition. 

To parse the equation: 

 Click the Parse button. 

Accepting an Equation 
Once an equation has been defined, it must be accepted. 

To accept an equation: 

 Click Done. 

To reject an equation: 

 Click Cancel. 

Auto-Cursor Feature Finding 
The auto-cursor feature will place up to 10 cursors on each acquired trace as a mathematical 
function of a variable or at a specific time or frequency. BioSigRZ supports automatic feature 
finding to minimize the amount of manual cursor manipulation that has to be performed after data 
acquisition. 



76 

BioSigRZ Manual 

 

Placement 
The settings under Placement allow you to specify placement of the cursor on the feature selected 
from the drop-down menu. The Placement will search over the specified range around the value 
calculated by the algebraic equation. 

Absolute 

The cursor will be placed at the position specified by the algebraic equation. 

Peak 

Cursor will be placed at the highest peak in the specified range. 

Valley 

Cursor will be placed at the lowest valley in the specified range.  

Max Mag 

Cursor will be placed at the maximum ± value in the specified range. 

Zero Crossing 

Cursor will be placed at the nearest zero crossing in the specified range. 

Rising ZC 

Cursor will be placed at the nearest rising (i.e. positive going) zero crossing in the specified range. 

Falling ZC 

Cursor will be placed at the nearest falling (i.e. negative going) zero crossing in the specified 
range. 
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Max Slope 

Cursor will be placed on the maximum slope (either positive or negative) in the specified range. 

Max Pos Slope 

Cursor will be placed on the maximum positive slope in the specified range. 

Max Neg Slope 

Cursor will be placed on the maximum negative slope in the specified range. 

Search From and To 
This specifies the search range for the feature (e.g. peak, valley etc.). AC stands for AutoCursor.  

For example, if the feature is set to peak and the result of the algebraic equation is 5 ms and the 
search range is From: AC –1.0  To: AC +1.0, the auto cursor will be placed on the highest peak 
between 4.0 ms and 6.0 ms. 

Multiplicative 
By default, the range specified in the search box will be added to the result of the algebraic 
equation. If the multiplicative box is checked, the range will be multiplied by the result of the 
algebraic equation. 

Flag Edge Placements 
If the placement of the cursor occurs at the beginning or end of the search range, clicking Flag 
Edge Placements, will cause the cursor to be flagged as such. For example, if the cursor placement 
was set for a peak at 5 ms (as in the following example), but the peak actually occurred before the 
search window, the cursor would be placed at the Start of the search window and would be 
flagged. This will let you know that you might want to manually move the cursor to the true peak, 
which was outside the search window. 

Cursors in the Auto-Cursor Equation 
When an auto-cursor’s value is calculated based on the value of another auto-cursor, the 
calculation is performed on the absolute value of the cursors. 

For example if two cursors are placed on the signal and the first one (C1) uses peak finding over a 
200 Hz range while the second cursor (C2) is calculated as C1 + 100 Hz, the second cursor will be 
placed as a function of the absolute value of C1, not the value actually found in the search over the 
200 Hz range. 

Understanding BioSigRZ Operational Modes 

Functions controlling the presentation of stimuli and the acquisition of data are controlled from the 
Operations Menu or from buttons displayed on the main window. The title and function of these 
menu options and buttons vary, depending on the current operational mode. For more information 
about modes, see The Operations Menu on page 31. 

Operational modes consist of the following: 

o Idle: No stimulus presentation or data averaging. 

o Running: Stimulus is being presented. 

o Averaging: Response data is being acquired and averaged. 

o Paused: Data averaging has been temporarily suspended. 
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Idle Mode 

 
When BioSigRZ is in idle mode, no stimulus signals are presented and no data is acquired. It is 
during idle mode that you specify parameters, configure displays, and review hardware 
configurations.  

To check the hardware configuration: 

1. Click the Review Button.  
 
This prompts the Transducer Setup and Settings. 
 

 
 
This dialog allows you to review the currently configured hardware configuration.  

2. After you have reviewed the dialog and verified that the setup is correct, click Done. 
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Start is the only operation available in idle mode. Clicking the Start button begins stimulus 
presentation and causes BioSigRZ to enter running mode. 

To present the stimulus: 

When in idle mode, 

 Click the Start button or select Start from the Operations menu. 

Running Mode 

 
When in running mode, BioSigRZ continuously presents the stimulus signal based on the variable 
values associated with the current SGI as defined in the stimulus schedule. No data is averaged in 
running mode. 

Stop and Begin are the only operations available in running mode. Clicking the Stop button halts 
stimulus presentation and returns BioSigRZ to idle mode. Clicking the Begin button begins data 
averaging, placing BioSigRZ in averaging mode. 

To view the stimulus: 

1. Access the Control Plot Toolbar of the Multi-purpose Plot. 

2. Click the Stimulus Signal  button or press ‘S’ on the keyboard. 

You may alter the scale of the display or change the number of displayed channels through use of 
the Plot Control Toolbar. 

To manually halt stimulus presentation: 

While in Running mode, 

 Click the Stop button or select Stop from the Operations menu. 

To begin averaging data: 

While in Running mode, 

 Click the Begin button or select Begin from the Operations menu. 
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Averaging Mode 

 
During averaging mode, BioSigRZ acquires data and calculates a running average. Data will be 
acquired until enough records have been gathered to compute the final averaged signal. At that 
time, the averaged signal will be appended to the end of the History Plot, the SGI will be 
incremented, a new stimulus signal will be generated according to the current stimulus parameters, 
and a new average will be computed. This process continues until the termination of the stimulus 
schedule is reached or until you manually end data averaging. 

During averaging mode, the operations End and Pause are available. In addition, you may access 
four manual control functions: Advance, Skip, Repeat, and ReDo. These functions are defined in 
the Real-Time Control section of this chapter on page 82. 

During data acquisition, you may use the Multi-Purpose Plot to view: 

o The stimulus signal 

o The raw A/D input 

o The frequency domain 

o The EEG signal 

o The running average 

o Nothing 

To choose a signal type for display in the Multi-Purpose Plot: 

1. Access the Plot Control Toolbar of the Multi-purpose Plot. 

2. Click the appropriate button. 

You may alter the scale of the display or change the number of displayed channels through use of 
the Plot Control Toolbar. See The Multi-Purpose Plot on page 42 for more information. 

To manually end data averaging: 

While in Averaging mode,  

 Click the End button or select End from the Operations menu. 

BioSigRZ will return to Running mode. The current stimulus signal will continue to be presented 
until manually halted as described previously. 

To pause data averaging: 

While in Averaging mode, 

 Click the Pause button or select Pause from the Operations menu. 

Data averaging will pause. The stimulus signal will continue to be presented. 
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Paused Mode 

 
In paused mode, data averaging is temporarily halted. Stimulus presentation continues.  

From paused mode, the operations End and Resume are available. The four manual control 
functions, Advance, Repeat, Skip, and ReDo are also available. These functions are defined in the 
Real-Time Control section of this chapter on page 82. 

To resume data averaging: 

 Click the Resume button or select Resume from the Operations menu. 

To manually end data averaging: 

While in Averaging mode, 

 Click the End button or select End from the Operations menu. 

BioSigRZ will return to Running mode. The current stimulus signal will continue to be presented 
until manually halted as described previously. 

Control of Data Acquisition 

You may control data acquisition automatically or in real-time. 

Automatic Control 
Automatic control begins with the specification of the stimulus schedule. Once the stimulus 
schedule has been specified, you may make further modifications to automatic stimulus 
presentation through use of some of the SGI Control features shown above. 

Modifying the Stimulus Schedule 
The manner in which stimulus parameter values vary as a function of the SGI is initially defined 
during signal design in SigGenRZ. You may make further modifications to the stimulus schedule 
from within BioSigRZ. See Specifying the Stimulus Schedule on page 62 for more information. 

Note: The Modify Schedule option in the Operations menu provides access to the SigGenRZ 
Variable Control dialog box, from which you may alter the stimulus schedule. 

Automatic Repetition of the SGI 
You may wish to repeat an SGI automatically. BioSigRZ allows you to automatically present an 
SGI once, twice, or three times. 
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To present an SGI once only: 

 Make sure that the Each Twice and Each Thrice checkboxes are not checked. 

To present an SGI twice: 

 Check the Each Twice box. 

To present an SGI three times: 

 Check the Each Thrice box. 

Real-Time Control 
You may wish to control data averaging in real time. BioSigRZ provides several functions that 
allow you to override the current stimulus schedule. These functions include: 

o Advance 

o Skip 

o Repeat 

o ReDo 

o Continuous Avg. 

o Manual SGI Control 

o Dynamic Variable Control 

Note: In some cases, real-time control of data averaging will result in averaged signals based on 
some number < N, where N is the number of signals per average that you specified during setup. 
The actual number of signals used to compute the average is associated with the record and stored 
in the BioSigRZ record file, (.arf file). It may be viewed from the BioSigRZ Cursor Edit Screen. 
See Viewing Records in Detail on page 94 for more information. 

 

Advance 
The Advance function causes the stimulus to advance to the next SGI specified in the stimulus 
schedule. This menu option is enabled in Averaging and Paused modes, only. When advance is 
chosen, the following process occurs: 

1. Stimulus presentation at the current SGI is halted. 

2. The running average for the current SGI is saved to the BioSig record file (.arf file). 

3. The averaged signal is appended to the history plot. 

4. Stimulus presentation is advanced to the next SGI as defined in the stimulus schedule. 

5. A new stimulus signal is generated based on the stimulus parameters for the new SGI. 

6. Data averaging begins at the new SGI. 

To advance data averaging to the next SGI: 

While in Averaging or Paused mode,  

 Click the Advance button or select Advance from the Operations menu. 
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Skip 
The Skip function causes the stimulus to skip the current SGI. This menu option is enabled in 
Averaging and Paused modes. The process is as follows: 

1. The average for the current SGI is discarded. 

2. Stimulus presentation is advanced to the next SGI specified in the stimulus schedule. 

3. A new stimulus signal is generated based on the stimulus parameters for the new SGI. 

4. Data averaging begins at the new SGI. 

To skip the current SGI: 

While in Averaging or Paused mode, 

 Click the Skip button or select Skip from the Operations menu. 

Repeat 
The Repeat function repeats the current SGI. This menu option is enabled in Averaging and 
Paused modes. The process is as follows: 

1. The running average for the current SGI is saved to the BioSig record file (.arf file). 

2. The averaged signal is appended to the history plot. 

3. The stimulus is re-presented at the current SGI. 

4. This second average is also saved to the BioSig record file (.arf file) and appended to the 
history plot. 

To repeat the current SGI: 

While in Averaging or Paused mode, 

 Click the Repeat button or select Repeat from the Operations menu. 

ReDo 
The ReDo function restarts the current SGI. This menu option is enabled in Averaging and Paused 
modes. The process is as follows: 

1. The average for the current SGI is discarded. 

2. The stimulus is re-presented at the current SGI. 

3. This second average is saved to the BioSig record file (.arf file) and appended to the history 
plot. 

To re-do the current SGI: 

While in Averaging or Paused mode, 

 Click the ReDo button or select ReDo from the Operations menu. 

Continuous 
Choosing Continuous causes BioSigRZ to continuously average data. When Continuous is chosen, 
BioSigRZ will continue to average response data indefinitely, regardless of n, the number of 
signals per average that you specified during setup. 

To enable continuous data averaging: 

 Check the Continuous Avg. checkbox or select Continuous from the Operations menu. 
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To disable continuous data averaging: 

 Uncheck the Continuous Avg. checkbox or select Continuous from the Operations menu. 

This will disable continuous data averaging. Data averaging will continue based on the acquisition 
parameters that you specified during setup. 

To halt continuous data averaging: 

 Click the End button or select End from the Operations menu. 

This will end all data averaging. 

Manual SGI Control 

 
You may manually advance stimulus presentation through use of Manual SGI Control. 

To enable manual control: 

 Check the Manual checkbox. 

To advance to the next SGI: 

 Click the  button. 

To return to a previous SGI: 

 Click the  button 

Dynamic Variable Control 
You may manually control stimulus presentation through the use of dynamic variables. A variable 
may be defined as dynamic during design in SigGenRZ or during modification in BioSigRZ. The 
value of a dynamic variable may be changed at any time during stimulus presentation. 

To display all dynamic variables: 

 Select Dyn Controls from the View menu. 

A dynamic variable settings prompt will be displayed for each dynamic variable. 

To change the current value of a dynamic variable: 

1. Click the Current button.  

2. Enter the desired value. 

3. Click OK. 

You may wish to dynamically specify a step value, or Delta value. A Delta value defines how the 
variable will be modified with each SGI. The Next button displays the projected value of the 
variable for the next SGI given the current Delta value. 
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To specify a Delta value: 

1. Click the Delta button. 

2. Enter the desired Delta value. 

3. Click OK. 

You may wish to override the value of the variable for the next SGI.  

To override the next value: 

1. Click the Next button. 

2. Enter the desired value. 

3. Click OK. 

You may wish to decrement the variable by the specified Delta value. You may reverse the sign of 
the Delta value by clicking the +/- Delta button. 

Acquisition Filter Controls 

 
BioSigRZ provides three dynamic filter controls for adjusting acquisition corner frequencies and 
filter characteristics. Highpass, lowpass, and notch filters provide a comprehensive selection of 
filter configurations. The Acquisition Filtering control applies the selected filter settings during 
Running and Averaging modes.  

To configure acquisition filters: 

 Select the filter characteristics using the drop-down menu for the desired filter type(s). 

The filter effects can be observed in the EEG and RAW A/D plots during Running Mode for fine 
tuning prior to averaging and recording. See the Multi-Purpose Plot on page 42 for more 
information on these plot display. 
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Chapter 5   Data Analysis 

BioSigRZ provides numerous analysis functions. Using these functions you may: 

o Obtain detailed information about specific records. 

o Designate a history record for use as a comparison. 

o Perform calculations involving one or more records. 

o Build and print customized reports. 

Using the History Plot and BioSigRZ Record Files 

 

Current Info History Plot 

BioSigRZ’s History Plot and BioSigRZ record files are central to all BioSigRZ data analysis 
capabilities.  

The History Plot: From the History Plot, you may select records for further analysis. Signals are 
automatically appended to the History Plot as they are averaged.  

BioSigRZ Record Files: BioSigRZ record files store averaged signals for later analysis. As 
signals are averaged they are appended to the currently defined BioSigRZ record file (.arf file).  

Through use of the History Plot and .arf files, you may easily average, organize, store, retrieve, 
and analyze signal records at any time.  

o Averaged data is automatically appended to the History Plot. 

o Averaged data is automatically appended to the currently specified .arf file. 

o Records may be retrieved from a specified .arf file for display in the History Plot. 

o Records may be saved to a separate .arf file. 

o Records may be saved to an ASCII text file (.txt file) or CSV (spreadsheet) file for use by 
other applications. 

o Records may be deleted from an .arf file. 
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Specifying the Current BioSigRZ Record File 
Prior to averaging data, you must specify the BioSigRZ record file (.arf file) to which averaged 
data will be appended. You may specify the .arf file in one of two ways: 

o You may specify a default .arf file during acquisition setup. 

o You may define the current .arf file when prompted immediately prior to data acquisition. 

See Defining Data Acquisition Parameters on page 57 for more information. 

Loading Records 
BioSigRZ organizes averaged records into groups. A new group is begun each time you "Begin" 
data averaging and is ended each time you "End" data averaging. From the Access Record Groups 
dialog box, you may: 

o Retrieve groups of averaged signals. 

o Export specific groups to separate .arf files. 

o Export specific groups to ASCII text files (.txt files). 

o Delete groups of records from the .arf file. 

To prompt the Access Record Groups dialog box: 

1. Select Access Record File from the History menu. 

2. Specify the desired file name and click Done. 

 
The Access Record Groups dialog box displays the following information: 

No: This column displays the group number. 

Subject ID: The Subject ID associated with the group of records is displayed in this column. 

Reference1: This column displays the Reference 1 information assigned to the group. 



Chapter 5: Data Analysis  89 

Reference2: This column displays the Reference 2 information assigned to the group. 

No. Recs: The number of records in the group is displayed in this column. 

Date/Time: This column displays the date and time the group of records was acquired. 

S.G. File: The S.G. File column displays the name of the SigGenRZ file used to generate the 
stimulus signal. 

Selecting Groups 
Windows provides standard procedures for selecting/deselecting groups. You may use these 
procedures to select groups from the Access Record Groups dialog box. 

To deselect all groups: 

 Click the Deselect All button. 

Performing Actions 
Groups may be loaded into the History Plot, deleted from the .arf file, exported to another .arf file, 
or exported to an ASCII text file (.txt file) or CSV (spreadsheet) file.  

To load, delete, or export a group of records: 

1. Select the desired groups. 

2. Click the appropriate button. 

If the chosen action is Load, then you will see the Select Records to Load dialog box. 
 

  
 Select the record(s) you wish to load and Click Load Sel. Or load all the records by clicking 

Load All. You may manually select/deselect records for loading or you may use the Select 
buttons to automatically select/deselect records. 



90 

BioSigRZ Manual 

If the chosen action is Delete, you will be prompted "Are you sure?"   

 Answer Yes to delete the selected groups from the file. The Access Record Groups dialog box 
will remain open. 

If the chosen action is an export, you will be asked to supply the export file name. The selected 
groups will be saved to the designated file. The Access Record Groups dialog box will remain 
open.  

Access Another BioSigRZ Record File 

 

To access another BioSigRZ Record File: 

1. Click the Select File button. 

2. Select the desired file. 

Closing the Load Record Group Dialog Box 

To close the Load Record Group dialog box: 

 Click the Done button. 

The History Plot  

 

Customizing History Info 
You may customize the information displayed in the History Info area. 

To customize the History Info area: 

 Click the right mouse button in the History Info area. 

You will see the Info-Bar Setup dialog box. 

History Info 
Area 

History Plot 
Area 
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From this box you may specify items to be displayed in the History Info area. You may also 
associate a group color with a particular variable. Group colors are created from the General 
Display Options dialog box. See page 48 for more information. 

Display Items: From the Display Item group box, you may specify all information to be displayed 
in the History Info area. Display items consist of the following: 

o SGI: The current SigGen Index. 

o Record No: The current record number. 

o Gain: The gain as currently defined in the Acquisition Setup dialog box. 

o No. Averages: The number of signals from which the average was calculated. 

o No. Artifacts: The total number of signals discarded due to artifact rejection. 

o Start Time: The start time of data acquisition. 

o T1 - CompT1: The difference in milliseconds between Cursor 1 of the current record and 
Cursor 1 of the Comparison record.  

o T2 - CompT2: The difference in milliseconds between Cursor 2 of the current record and 
Cursor 2 of the Comparison record.  

o dV/CompV: Delta V percentage calculated as follows: 
V of the current record/V of the Comparison record * 100 

To select information for display in the History Info area: 

 Check the desired box (you may check multiple boxes). 

Display Variables: You may specify which, if any, variables you wish to display. Chosen 
variable names and current variable values will be displayed for each record in the History Plot. 
You may also assign a color to a variable. Finally, you may customize the variable display by 
abbreviating the variable names or excluding the unit description (e.g., ms, Hz, dB). 
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To select variables for display in the History Info area: 

 Check the desired box (you may check multiple boxes). 

To assign a color to a variable: 

1. Create the desired Group Color (A or B) from the General Display Options dialog box. 

2. Check the desired color, Code-A or Code-B. 

To abbreviate variable names: 

 Check the Abbreviate Variable Names check box. All variable names will be abbreviated. 

To exclude unit descriptions: 

 Check the Exclude Unit Descriptions check box. All unit descriptions will be excluded. 

Exporting History Plot Records 
Groups of records can be reorganized through use of the Load Record Group dialog box. 
Individual records can be reorganized through use of the History Plot. 

Individual History Plot records may be exported to another .arf file or exported to an ASCII text 
file (.txt file) or CSV spreadsheet file.  

To export History Plot records: 

1. Select the desired records. 

2. Select the desired export action from the History menu. 

a. If Export to ARF file is selected supply the file name and click Open to save the 
file. 

b. If Export to ASCII file is selected supply the file name and click Open to save the 
file.  

c. If Export to CSV is selected, the CSV File Export dialog is prompted. 

CSV File Export Dialog 

The Export to CSV option allows you to export raw trace data along with descriptions into a 
standard spreadsheet file. Each row in the spreadsheet file contains all of the data for one record. 
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Selecting Items 
You may select one or more miscellaneous item, SigGen variable, or cursor.  

To select individual items: 

 Check the appropriate box. 

To select all items within a box: 

 Click the All button. 

To deselect all items within a box: 

 Click the None button. 

Misc. and SigGen Variables 
Saves the selected fields to the spreadsheet file. 

Cursors 
X/Y Values: Exports both X and Y values for cursors. 

X Values: Exports only X values for cursors. Does not export Y values. 

Indexes: Exports the indices of the cursors. This indicates which sample in the waveform the 
cursor was located on. 

Trace Data 
Sample Period: Sampling period in microseconds of the acquired data. 
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No. of Samples: Number of samples in the trace. 

O.S. Time/Freq: Offset of the first point in waveform in ms for Time or Hz for Frequency. 

Data Samples: Saves the data for the waveform. 

Units 
Scales the output to the units that are selected. For example, a cursor value that is .0001 V will be 
output as 100.0 µV if microvolts are selected. 

Output Format: Sets the output format of the data. For example #.### will export data to three 
decimal places. 

Template  
Saves the export settings from the CSV File Export dialog box to a file that can be reloaded later. 

Report Name 
You must specify how the report is to be formatted. Additionally, you may give the report a title. 

To define a title: 

 Enter the title in the Title field. 

Generating the Report 

To generate the report: 

Press the Generate Report button. 

Making a Comparison Record 

BioSigRZ allows you to choose a record for comparison with other data records. Any record 
currently displayed in the History Plot may be used as a comparison record. 

The comparison record may be displayed in the Cursor Edit window. This window is explained in 
greater detail in the following section, "Viewing Records in Detail."  The comparison record may 
also be displayed in the Multi-Purpose Plot during data acquisition. 

To make a comparison record: 

1. Click the desired record. 

2. Select Toggle Comparison from the History menu or Ctrl+Double-click the desired record. 

To display a comparison record in the Multi-Purpose Plot: 

1. Select Show Comparison from the Multi-Plot menu. 

2. Select Running Average from the Multi-Plot menu. 

The comparison record will be displayed along with the running average. 

Viewing Records in Detail 

You may wish to view individual history records in greater detail. From the Cursor Edit window, 
you can: 

o View a more detailed plot of the time-domain waveform. 
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o View frequency-domain information. 

o View subject information. 

o Place cursors to obtain intensity and time information. 

o View information pertaining to the SGI. 

To access the Cursor Edit window: 

 Double-click the desired history plot record. 

or  

 Click the desired history plot record and select Edit Cursors from the History menu. 

 

Time-Domain Plot 
The Cursor Edit window contains two waveform plots. The upper plot displays the time-domain 
waveform. The x-axis is labeled in units of time. The y-axis is labeled in Volts. 

Using Zoom 
You may zoom-in on a portion of the time-domain waveform. 

To zoom-in on a portion of the time-domain waveform: 

1. Place the mouse pointer at the beginning of the zoom area. 

2. Hold down the left mouse button. 

3. Drag the mouse pointer to the end of the zoom area. 

4. Release the left mouse button. 

5. Repeat for additional zoom. 
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To return to the original time-domain waveform: 

 Click the right mouse button anywhere in the Time-Domain Plot. 

Frequency-Domain Plot 
BioSigRZ performs a Fast Fourier Transform (FFT) on the waveform displayed in the Time-
Domain Plot. The resulting frequency-domain waveform is displayed in the lower plot on the 
BioSig Cursor Edit window. The x-axis is labeled in Hz. The y-axis is labeled in dB Volts. 

Using Zoom 
You may zoom-in on a portion of the frequency-domain waveform. 

To zoom-in on a portion of the frequency-domain waveform: 

1. Place the mouse pointer at the beginning of the zoom area. 

2. Hold down the left mouse button. 

3. Drag the mouse pointer to the end of the zoom area. 

4. Release the left mouse button. 

5. Repeat for additional zoom. 

To return to the original frequency-domain waveform: 

 Click the right mouse button anywhere in the Frequency-Domain Plot. 

Subject Information 
Subject information is displayed in the Group Info group box. This box displays the following 
information: 

Group Info: Each time you initiate Averaging mode by choosing Begin, a new data group is 
created and appended to the end of the BioSig record file (.arf file) and to the end of the History 
Plot. Groups are numbered sequentially. The Group Info title displays the group number of the 
current record.  

Subject ID: This read-only field displays the subject ID that you assigned during the initiation of 
Averaging mode. 

Ref1 and Ref2: These read-only fields display other subject data that you assigned during the 
initiation of Averaging mode. 

Memo: This read-only field displays any additional text information that you assigned during the 
initiation of Averaging mode.  

Cursors 
You may place up to 10 cursors in the Time-Domain Plot. Cursors may be used to obtain specific 
information concerning: 

o Level at a specific point 

o Time at a specific point 

o Change in time (T) between two points 

o Change in voltage (V) between two points 

Working with Cursors 
Cursors may be manipulated in various ways. 
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To place a cursor in the Time-domain Plot: 

 Double-click the desired position. 

 or 

1. Click the Add Cursor button. 

2. Move the Cursor to the desired position. 

Note: Placing a cursor is more precise if you first zoom-in on a portion of the signal. 

To move a cursor: 

1. Place the mouse above the cursor. 

2. Hold down the left mouse button. 

3. Drag to the desired position. 

Note: Moving a cursor to a new position is more precise if you first zoom-in on a portion of the 
signal. 

To select a cursor: 

1. Click the cursor. 

2. The selected cursor text appears surrounded by a small box. 

To delete a cursor: 

1. Select the desired cursor. 

2. Click the Delete Cursor button. 

Cursor Info 

 
Information about the selected cursor is displayed in the Cursor Info group box. 

Cursor Info: The title of the Cursor Info group box displays the number of the currently selected 
cursor. 

Time: The Time field displays the time value associated with the currently selected cursor. 

Level: The Level field displays the instantaneous intensity level associated with the currently 
selected cursor. 

Tn - T1: This field displays the difference in time (T) between the selected cursor (Cursor n) and 
Cursor 1. 

Ln - L1: This field displays the difference in intensity (L) between the selected cursor (Cursor n) 
and Cursor 1. 
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RMS 1>2: This field displays the RMS amplitude as calculated between cursors 1 and 2. 

Text: The text field displays the label associated with the currently selected cursor. You may edit 
this label. 

To edit the cursor label: 

1. Type the desired text in the Text field. 

2. Click the cursor. 

The cursor label will be updated. 

To move the cursor label relative to the cursor: 

1. Place the mouse pointer over the desired label. 

2. Hold down the left mouse button and drag the label to the desired position. 

3. Release the left mouse button. 

Default: Clicking the Default button causes the label of the currently selected cursor to return to 
its default setting. 

Hide: Checking this box hides the label of the currently selected cursor. 

Lock Position: You may lock the position of the currently selected cursor by checking the Lock 
Position box. 

Comparison Data 

 
Information about the relationship of the current record to the comparison record is displayed in 
the Comparison Data group box. 

To display the comparison record: 

Check the Show Comparison checkbox. 

The comparison record will be displayed in the Time-domain plot along with the current record. 
The location of cursors in the comparison plot will be displayed with vertical dashed lines. 

Delta T1: This field displays the difference in time between Cursor 1 of the current record and the 
comparison record. 

Delta T2: This field displays the difference in time between Cursor 2 of the current record and the 
comparison record. 

Delta V: This field displays a percentage value computed as follows: 

V of the current record / V of the Comparison record * 100 



Chapter 5: Data Analysis  99 

Record Information 

 
Information about the current record is displayed in the Record Info group box. 

SigGen Index: The SGI associated with the current record is displayed in the SigGen Index field. 

Channel: The current channel is displayed in the Channel field. 

Time: The duration of the record is displayed in the Time field. 

Averages: The number of sweeps included in the average is displayed in the Averages field. 

Artifacts: The number of responses discarded due to artifact rejection is displayed in the Artifacts 
field. 

Variables: The Variables box contains a list of all signal variables and their current values. 

Using the Worksheet 

 
You may use the Worksheet to set aside records for mathematical operation or to build and print 
reports. The process is simple and straightforward. 

1. Place all desired History Plot records into the Worksheet. 

2. Format tokens and traces. 

3. Select records in the Worksheet for mathematical operations. 

4. Perform mathematical operations using the Calculator. 

5. View Worksheet records in detail. 

6. Organize the report. 

7. Print the report. 

Token 
Trace 
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Placing Records 

To place History Plot records into the Worksheet: 

1. Select the desired record(s). 

2. Select To Worksheet from the History menu. A box appears in the Worksheet. 

3. Move the box to the desired location. 

4. Click the left mouse button. 

or 

1. Select the desired record(s). 

2. Drag the selected record(s) from the History Plot to the Worksheet. 

The selected History Plot record(s) will be placed into the Worksheet. 

Formatting Tokens and Traces 
You may customize the following: 

o The general worksheet area 

o Specific tokens 

o Specific traces 

Customizing the General Worksheet 
You may customize the Worksheet area from the Worksheet Preferences dialog box. This dialog 
box controls the default behavior of the Worksheet. 

To access the Worksheet Preferences dialog box: 

 Click the right mouse button anywhere in the Worksheet, but not directly above a trace or a 
token. 
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The Worksheet Preferences dialog box is divided into two sections: 

o Default Trace/Token Behavior 

o Display Options 

Preference settings located within the Default Trace/Token Behavior section affect trace or token 
parameters. These Worksheet preferences affect all records subsequently placed into the 
Worksheet. You can override these settings by specifically customizing tokens and traces as 
described in the Customizing Specific Tokens section below. 

Parameter settings located in the Display Options section affect the Worksheet as a whole.  

Token Assignments: You may assign up to five tokens for each Worksheet record. Tokens may 
consist of a variety of parameters.  

Parameter: Token Assignment parameters may be selected from the Parameter list 
boxes found in the Token Assignments group box. 

Include Description: Token Assignment parameters consist of a description and a 
number. For example, Channel and Record No. consist of a description (Chan: and Rn:, 
respectively) followed by a number. By default, all token descriptions are displayed. You 
may choose to omit the description from the Worksheet display. To do so, simply 
uncheck the appropriate Include Description check box. 

Trace Coloring Mode: You may wish to enhance the Worksheet display through the application 
of trace color. You may choose one of the following Trace Coloring Modes: 

Rotating Colors: Causes trace colors to rotate. Rotating colors are assigned based on the 
Trace colors you defined in the Worksheet Display Options dialog box. 

Color Piles Only: Assigns the same color to all records stacked in the same pile. 

Color Per Channel: Assigns unique trace colors for each channel. 

Unique Per Trace: Assigns a unique color to each trace. 

Token Coloring Mode: Token color may be assigned the following ways: 

Default Token Colors: Assigns the token colors you defined in the Worksheet Display 
Options dialog box. 

Match to Trace Color: Overrides the default token color and assigns the color of the 
associated trace. 

Display Options: You may control the look of the overall Worksheet display by specifying the 
following: 

Vertical Plot Size: Controls the vertical dimension of the plot. 

Show Cursors: Displays any cursors placed in the record. 

Show Margins: Shows/hides the margin lines used to separate Worksheet sections. 

Snap Grid: Controls the fineness of the Snap-to-Grid. This is the invisible grid onto 
which all Worksheet objects snap into place. 

Visible Grid: Controls the visible grid. You may choose no grid or control the resolution 
of the visible grid. 

Adjust Colors: From the Adjust Colors button, you may modify color settings through the 
Worksheet Display Options dialog box. 

Change All: Token and Trace preferences affect all records subsequently placed into the 
Worksheet. If you wish to change these preferences for records currently displayed in the 
Worksheet, you must click the appropriate Change All button.  
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Local Change All Buttons: You may modify existing Worksheet record parameters 
individually by clicking the appropriate "local" Change All button. Local Change All 
buttons are provided for the following: 

o Token Assignment parameters 

o Trace Coloring Mode settings 

o Token Coloring Mode settings  

Global Change All: You may modify existing Worksheet record parameters as a group 
by clicking the global Change All button. The Global Change All button simultaneously 
updates all parameters located in the Default Trace/Token Behavior section. 

Customizing Specific Tokens 

To customize a specific token: 

 Click the right mouse button on the desired token. 

You will see the Token Options dialog box. From here you can modify the token, position the 
token, change its text, or cause it to be hidden. 

 
Parameter and Include Description: You may change the Parameter and show/hide the token 
description. For more information, see the above section, "Customizing the General Worksheet." 

Text: You may customize the token by entering the desired text in this field. Note: To change a 
token's text you must first choose User Text from the Parameter list. 

Auto-Place: Realigns the token with its trace. 

Hide: Hides the token. 

Copy Relative Position: Copies the position of the token relative to its trace to all other traces and 
tokens. 

Delete: Deletes the token. 

Customizing Specific Traces 

To customize a specific trace: 

 Click the right mouse button on the desired trace. 

You will see the Response Trace Options dialog box. From here you can modify the trace color, 
position the trace, edit its token, delete the trace, or cause its tokens to be hidden. 
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Trace Coloring Mode and Token Coloring Mode: You may set the Trace or Token coloring 
modes. For more information see the previous section, Customizing the General Worksheet. 

Set Color: This button accesses the Color dialog box, from which you may set custom colors. 

Edit Tokens: You may edit the tokens associated with a specific trace. Clicking the desired token 
button opens the Token Options dialog box (see previous section). 

Hide All: Hides all tokens associated with the current trace. 

Show All: Shows all tokens associated with the current trace. 

Auto Position All: Realigns all associated tokens with the current trace. 

Delete Trace: Deletes the current trace. 

Selecting Worksheet Records 
Various Calculator and Worksheet formatting functions require the selection of one or more 
record.  

To select specific records: 

 Ctrl+Click the desired trace(s). The record's token will appear in reverse color. 

Note: You must Ctrl+Click the trace. A Ctrl+Click on the token will not select the record. 

To select all records: 

 Select Select All from the Worksheet menu or press the Spacebar. 

To select contiguous records: 

1. Hold down Ctrl and the left mouse button. 

2. Drag until the box surrounds all desired records 

3. Release the left mouse button and the Ctrl key. 

To deselect specific records: 

 Ctrl+Click the desired selected trace(s). 

Note: You must Ctrl+Click the trace. A Ctrl+Click on the token will not deselect the record. 
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To deselect all records: 

 Select Deselect All from the Worksheet menu or press Ctrl+Space bar. 

Performing Mathematical Operations 
You may perform a variety of mathematical operations on Worksheet records. These operations 
are described in detail in Using the Calculator, page 106. 

To perform a mathematical operation: 

1. Select the desired Worksheet record(s). 

2. Click the appropriate Calculator button. 

or 

 Select the appropriate Calculator menu option. 

Viewing Worksheet Records in Detail 
You may view a worksheet record in detail from the BioSig Cursor Edit dialog box. 

To access the BioSigRZ Cursor Edit dialog box: 

 Double click on the desired Worksheet record. 

Organizing the Report 

Moving a Record 
You may move individual records. Moving a record moves both the trace and all associated 
tokens. 

To move a record: 

1. Place the mouse pointer over the trace. 

2. Hold down the left mouse button. 

3. Drag the record to the desired position. 

4. Release the mouse button. 

Note: You must place the mouse pointer over the trace. Placing the mouse pointer over the token 
will move the token only. 

To move a group of records: 

1. Select the desired records. 

2. Place the mouse pointer over a selected trace. 

3. Hold down the left mouse button. 

4. Drag the records to the desired position. 

5. Release the mouse button. 

Note: Selected records always move as a block. If you wish to move only one record of a selected 
block, deselect the record, move it, and then re-select the record. 

Moving a Token 
You may wish to move a token relative to its associated trace. 
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To move a token: 

1. Place the mouse pointer over the token. 

2. Hold down the left mouse button. 

3. Drag the token to the desired position. 

4. Release the mouse button. 

Using the Worksheet Buttons 
Located below the Calculator, the five Worksheet buttons can be used to format and organize the 
Worksheet. These functions may also be found in the Worksheet menu. 

Button Menu Option Action 

 
Space Evenly Spaces all selected plots evenly throughout the Worksheet. 

 
Spread Apart Spreads all selected plots apart.  

 
Squash Together Squashes all selected plots together. 

 

Pile Piles all selected plots on top of one another. 

 

UnPile Unpiles all selected plots. 

 

Delete Deletes the currently selected Worksheet records. 

Printing a Report 
BioSigRZ provides the standard Windows functions: Print Setup, Print Preview, and Print. 

To setup the printer: 

 Select Print Setup from the File menu. 

To preview the Worksheet: 

 Select Print Preview from the File menu. 

To print the Worksheet: 

 Select Print from the File menu. 

Exporting Worksheet Records 
All Worksheet data may be saved to an ASCII or CSV file. Such data can be accessed by other 
applications. 

To export Worksheet records: 

1. Select the desired records. 

2. Select the desired export action from the Worksheet menu. 



106 

BioSigRZ Manual 

a. If Export to Ascii is selected you will be asked if you wish to include detailed group 
information (additional information such as the .sig file names, number of records, 
subject ID, reference and memos). 

i. Supply the file name and click Open to save the file.  

b. If Export to CSV is selected, the CSV File Export dialog is prompted. See page 92  
for more information. 

Saving and Opening Worksheet Files 
Reports may be saved in BioSigRZ Worksheet files. The extension for these files is .awf. 

Saving BioSigRZ Worksheet Files 

To save a new BioSigRZ Worksheet file: 

 Select Save Worksheet As from the Worksheet menu. 
 
The Save As dialog box will be displayed. You may assign a name to your new signal. 

To save an existing file: 

 Select Save Worksheet from the Worksheet menu. 
 
 The file will be saved with its current name. 

Opening BioSigRZ Worksheet Files 

To open a BioSigRZ worksheet file: 

1. Select Open Worksheet from the Worksheet menu or click the Worksheet Records  
button. 

2. Click on the desired file. 

3. Click Open. 

Using the Calculator 

The calculator provides numerous mathematical functions that may be applied to one or more 
Worksheet records. 

 

Calculator Functions 
o Scale 

o Invert Trace 

o Shift Baseline 
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o Remove Baseline 

o Zero Points 

o Crop 

o Add 

o Subtract 

o Average 

o Time Align 

o Time Shift  

o Smooth 

o Lowpass Filter 

o Highpass Filter 

o Bandpass Filter 

o Notch Filter 

o Hanning Window 

o Cosine^2 Window 

o Mag Spectrum 

o Copy Worksheet Record 

Scale 
The Scale function multiples each point in the selected Worksheet record(s) by a user-defined 
constant. This function may be used to increase or decrease the scale of a waveform displayed in 
the Worksheet. By specifying a negative scale factor, you may also invert the selected Worksheet 
record(s). 

To scale a Worksheet record: 

1. Select the desired record(s). 

2. Click  . 

 or 

 Select Scale from the Calculator menu. 

You will be prompted to enter the desired scale factor. This factor must be no less than -(1010) 
and no greater than 1010.  

Invert Trace 
Invert Trace multiplies each point in the selected Worksheet record(s) by -1, thereby inverting the 
waveform while maintaining its original scale. 

To invert a Worksheet record: 

1. Select the desired record(s). 

2. Click  . 

 or 

 Select Invert Trace from the Calculator menu. 
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Shift Baseline 
The Shift Baseline function adds a user-defined constant, or DC offset, to each point in the 
selected records(s), effectively shifting the baseline. 

To add a DC offset to a Worksheet record: 

1. Select the desired record(s). 

2. Click  . 

 or 

 Select Shift Baseline from the Calculator menu. 

You will be prompted to enter the DC offset. This offset must be no less than -1000 microvolts 
and no greater than 1000 microvolts.  

Remove Baseline 
A DC offset may be removed through the use of Remove Baseline. 

To remove a DC offset from a Worksheet record: 

1. Select the desired record(s). 

2. Click  . 

 or 

 Select Remove Baseline from the Calculator menu. 

Zero Points 
The Zero Points function allows you to "zero out" a specific portion of a Worksheet record. Zero 
Points will convert each point within the specified time range to a value of zero. 

To zero a portion of the record: 

1. Select the desired record(s). 

2. Click  . 

 or 

 Select Zero Points from the Calculator menu. 

You must specify the time interval within which you wish to convert all level values to zero. You 
will be prompted to enter a lower time boundary and an upper time boundary.  

Add 
The Add function adds two or more Worksheet records. 

To add Worksheet records: 

1. Select two or more records. 

2. Click  . 

or 
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1. Select Add from the Calculator menu. A box appears in the Worksheet. 

2. Move the box to the desired location. 

3. Click the left mouse button. The resulting record will be added to the Worksheet. 

Subtract 
The Subtract function allows you to subtract one Worksheet record from another. 

To subtract one Worksheet record from another: 

1. Select the record from which you wish to subtract. 

2. Select the record you wish to subtract. 

3. Click  . 

or 

1. Select Subtract from the Calculator menu. A box appears in the Worksheet. 

2. Move the box to the desired location. 

3. Click the left mouse button. The resulting record will be added to the Worksheet. 

Average 
The Average function calculates the average of two or more records. 

To average Worksheet records: 

1. Select two or more records. 

2. Click  . 

or 

1. Select Average from the Calculator menu.  
A box appears in the Worksheet. 

2. Move the box to the desired location. 

3. Click the left mouse button. The resulting record will be added to the Worksheet. 

Time Align 
The Time Align function lines up two or more records according to values on the time axis. 
Records will be aligned with the first selected record of the group. 

To time align Worksheet records: 

1. Select two or more records. 

2. Click  . 

or 

 Select Time Align from the Calculator menu. The records will be aligned in time. 

Time Shift 
The Time Shift function shifts the selected record(s) along the time axis. 
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To time shift Worksheet records: 

1. Select the desired record(s). 

2. Click  . 

or 

 Select Time Shift from the Calculator menu. 

You will be prompted to enter the amount of time shift in milliseconds. This number can be no 
less than -100 ms and no greater than 100 ms. 

Note: Once data points have been time-shifted off the Worksheet display, they cannot be 
retrieved. These points in effect no longer exist. All such points will appear as zero. 

Smooth 
The Smooth function smoothes a selected Worksheet through application of an averaging 
algorithm. The record is averaged with a shifted version of itself. 

To smooth a Worksheet record: 

1. Select the desired record(s). 

2. Click  . 

or 

 Select Smooth from the Calculator menu. 

You will be prompted to enter the number of smooth points. This is the number of points to be 
included in the average. For example, specification of 2 smooth points will cause the record to be 
average with a second version of itself shifted by one point. Specification of 3 smooth points will 
result in an average based on the original record, a version of the record shifted by one point, and a 
version of the record shifted by two points.  

The resulting record will be added to the Worksheet. 

Filtering 
BioSig provides functions allowing you to lowpass, highpass, bandpass filter, or notch filter 
Worksheet records. BioSig performs filtering through use of a Butterworth filter.  

In order to specify a filter, you must define certain filter parameters. These parameters include: 

o Corner frequency: Frequency at which the level has decreased by 3 dB.  

o Center frequency: The center frequency of a bandpass filter.  

o Filter Bandwidth: The bandwidth between lower and upper corner frequencies of a 
bandpass filter. Filter bandwidth is defined in octaves. Filter bandwidth must be at least 
0.01 octave and no greater than 10 octaves. 

o Filter order: The number of poles necessary to achieve a desired roll-off rate. Roll-off 
rate = 6 dB per octave per pole. Number of poles must be an even number. Number of 
poles must be at least 2 and no greater than 20. 
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Example: Specifying a Filter 
You may wish to specify a lowpass filter with a -3 dB frequency of 4000 Hz and a roll-off of 120 
dB per octave. You would define the following parameters: 

Corner frequency = 4000 Hz 

Filter order = 20 poles 

120 dB per octave/ 6 dB per octave = 20 poles 

To filter a Worksheet record: 

1. Select the desired record(s). 

Lowpass/Highpass Filter Bandpass or Notch Filter 

2. Click  or . 2. Click  or . 

3. Enter corner frequency. 3. Enter center frequency. 

4. Enter filter order. 4. Enter filter bandwidth. 

 5. Enter filter order. 

Hanning Window 
Applies a Hanning window to the selected worksheet record for use with the magnitude spectrum. 

To impose a Hanning Window to a Worksheet record: 

1. Select the desired record(s). 

2. Click  . 

or 

 Select Hanning Window from the Calculator menu. 

 

Cosine2 Window 
Applies a Cos2 window to the selected worksheet record (smoothes the start and end of the 
waveform). Used with magnitude spectrum. 

To impose a Cosine2 Window to a Worksheet record: 

1. Select the desired record(s). 

2. Click  . 

or 

 Select Cos^2 Window from the Calculator menu. 
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Mag Spectrum 
Generates an FFT of the data using 1024-8192 points per FFT. 

To impose a Mag Spectrum to a Worksheet record: 

1. Select the desired record(s). 

2. Click . 

or 

 Select Mag Spectrum from the Calculator menu. 

You will be prompted to enter the number of frequency points. This is the number of points to be 
included in the FFT used to compute the Mag Spectrum. 

Copy Worksheet Record 
Copies the selected worksheet record(s). 

To copy a Worksheet record: 

1. Select the desired record(s). 

2. Click . 


	Why BioSigRZ?
	Organization of the Manual
	BioSigRZ Quick Start
	Overview
	Quick Start Example

	Reference Guide

	Part 1  BioSigRZ Quick Start
	Chapter 1   Overview 
	What Is BioSigRZ?
	BioSigRZ Capabilities and Features
	Standard Configurations for ABR and DPOAE
	Standard Speaker and Microphone Profiles
	Stimulus Schedule Customization
	Stimulus Variable Customization
	Dual-Channel Stimulus
	Artifact Rejection
	Averaging
	Stimulus Schedule Override
	Historical Data Display
	Comparison Data Display
	Calculator
	Detail Displays
	Cursors
	Report Generation
	SigGenRZ File Support


	How to Use BioSigRZ
	Workflow for Initial Experiment Set-Up
	Workflow for Daily Operation
	Standard BioSigRZ Configuration Files

	System Requirements
	Hardware Configuration
	Typical ABR Configuration
	Typical DPOAE Configuration
	Eliminating Electrical Noise in ABRs

	BioSigRZ File Types
	BioSigRZ Configuration Files
	SigGenRZ Files
	Calibration Files
	BioSigRZ Record Files
	BioSigRZ Worksheet Files
	ASCII Text Files
	CSV Spreadsheet Files


	Example 1: ABR Using a Tone Stimulus
	Initial Experiment Setup
	Connect the Hardware
	Run the BioSigRZ Software
	Load the Standard Configuration
	Select Your Transducer and Device Input
	Specify a Response Record File
	Save the .acf File

	Daily Operation
	Load your Saved Configuration
	Prepare the Subject
	Review the Input/Output Settings
	Run the Experiment
	Running
	Averaging
	Termination


	Modifying a Stimulus Variable
	Load the Saved Configuration
	Review the Stimulus Variables
	The Stimulus Schedule
	Modifying Variables

	Save the .acf File



	Part 2 Reference Guide
	Chapter 2   Workspace Basics
	Getting to Know the BioSigRZ Main Window
	The Start-up Window
	The Customized Window

	Using the BioSigRZ Menus
	The File Menu
	The Setup Menu
	The Operations Menu
	The View Menu
	The Multi-Plot Menu
	The History Menu
	The Worksheet Menu
	The Calculator Menu
	The Help Menu

	Using the Toolbars
	The Toolbar
	The Plot Control Toolbar
	Common Plot Control Toolbar Features
	Scaling Section
	Auto-Scale
	Expand Scale
	Reduce Scale

	Customization
	Channels


	Multi-Purpose Plot
	Types of Displays
	Stimulus
	Raw A/D
	Frequency Domain
	EEG
	Running Average
	None


	The History Plot
	Scrolling Functions
	Editing Functions
	Selecting Records
	Editing


	The Calculator and Worksheet Buttons
	Calculator Functions
	Calculator Functions (Continued)
	Worksheet Functions

	The Worksheet
	Customizing Your Display
	Customizing the Layout
	Using Setups
	Returning to the Default Layout

	Customizing Cursor Strings


	Chapter 3   Configuration
	Opening and Saving Configuration Files
	Creating Configurations
	Defining Stimulus Parameters
	Defining the Stimulus
	Specifying the SigGenRZ File
	Stimulus Refresh
	Locking SigGen Files
	Reloading the SigGenRZ Stimulus File

	Presentation Timing
	Presentation Rate
	Presentation Period
	Ext. Trigger
	Continuous

	Speaker Calibration

	Defining Data Acquisition Parameters
	Response Record File
	Timing
	Setup Inputs
	Configuration
	Preprocessing
	Artifact Rejection
	Post Processing

	Microphone and Device Input Calibration

	Reviewing Calibration
	Specifying the Stimulus Schedule
	Viewing the Current Stimulus Schedule

	Modifying the Stimulus Schedule
	Modifying Variables
	Name and Units
	Commonly used Variable Methods
	Combination Variables
	Value Limits
	Default/Start
	Step Size
	Minimum
	Maximum
	No. of Steps

	SGI Modifiers
	Offset
	Repeat Factor
	Skip Factor   

	Termination Control
	Normal/None
	Boundary Control
	Loop


	Modifying the Target Device Setup
	Device Select 
	Type
	Index

	Circuit File Override
	Name



	Chapter 4   Data Acquisition
	Subject Definition
	Auto-Cursors
	Select Cursor
	Specifying the Algebraic Equation
	Enabling Auto-Cursoring
	Specifying the Equation
	Parsing the Equation
	Accepting an Equation

	Auto-Cursor Feature Finding
	Placement
	Absolute
	Peak
	Valley
	Max Mag
	Zero Crossing
	Rising ZC
	Falling ZC
	Max Slope
	Max Pos Slope
	Max Neg Slope

	Search From and To
	Multiplicative
	Flag Edge Placements

	Cursors in the Auto-Cursor Equation

	Understanding BioSigRZ Operational Modes
	Idle Mode
	Running Mode
	Averaging Mode
	Paused Mode

	Control of Data Acquisition
	Automatic Control
	Modifying the Stimulus Schedule

	Real-Time Control
	Advance
	Skip
	Repeat
	ReDo
	Continuous
	Manual SGI Control
	Dynamic Variable Control
	Acquisition Filter Controls



	Chapter 5   Data Analysis
	Using the History Plot and BioSigRZ Record Files
	Specifying the Current BioSigRZ Record File
	Loading Records
	Selecting Groups
	Performing Actions
	Access Another BioSigRZ Record File
	Closing the Load Record Group Dialog Box

	The History Plot 
	Customizing History Info
	Exporting History Plot Records
	CSV File Export Dialog

	Selecting Items
	Misc. and SigGen Variables
	Cursors
	Trace Data
	Units
	Template 
	Report Name
	Generating the Report


	Making a Comparison Record
	Viewing Records in Detail
	Time-Domain Plot
	Using Zoom

	Frequency-Domain Plot
	Using Zoom

	Subject Information
	Cursors
	Working with Cursors
	Cursor Info

	Comparison Data
	Record Information

	Using the Worksheet
	Placing Records
	Formatting Tokens and Traces
	Customizing the General Worksheet
	Customizing Specific Tokens
	Customizing Specific Traces

	Selecting Worksheet Records
	Performing Mathematical Operations
	Viewing Worksheet Records in Detail
	Organizing the Report
	Moving a Record
	Moving a Token
	Using the Worksheet Buttons

	Printing a Report
	Exporting Worksheet Records
	Saving and Opening Worksheet Files
	Saving BioSigRZ Worksheet Files
	Opening BioSigRZ Worksheet Files


	Using the Calculator
	Calculator Functions
	Scale
	Invert Trace
	Shift Baseline
	Remove Baseline
	Zero Points
	Add
	Subtract
	Average
	Time Align
	Time Shift
	Smooth
	Filtering
	Example: Specifying a Filter
	Hanning Window
	Cosine2 Window
	Mag Spectrum
	Copy Worksheet Record





